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1Welcome to Microsoft Picture It!

Congratulations on your purchase of Microsoft Picture It! Photo, a unique
combination of robust photo-editing tools and high-quality photo projects.
Although easy to use, Picture It! also offers powerful imaging technology that
helps you improve your photos.

What’s New?
Since the release of Picture It! 1.0 in 1996, Microsoft has repeatedly updated
Picture It! with new features, improved design, and innovative projects. Now in
its seventh version, Picture It! has been updated and improved once again, built
on a strong imaging foundation from years of research and feedback from
users. Improvements for Picture It! version 7.0 include:

■ A new file browser makes it even easier to obtain images from your
digital camera, scanner, hard-drive, or the Web.

■ An improved Mini Lab where you can perform common editing tasks on
several photos at the same time.

■ A new menu format that makes it easier to find the right tasks for editing
your photos.

■ New Instructional Videos that provide step-by-step guidance on how to
get started with Picture It!.

Other Helpful Resources
This Companion Guide is not an exhaustive resource for everything you can do
with Picture It!. For step-by-step instructions about using all the program’s
features, check out the online Help system, available from the Startup Window
or the Help menu. Or, for a demonstration of some key Picture It! features,
watch one of the Instructional Videos.

Digital photography is fun and exciting, and Picture It! makes it easy to get
great results.
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Starting Setup
To install Picture It!, you must be running Windows 98, Windows Me, Win-
dows 2000, or Windows XP or higher. On Windows 2000 and Windows XP
systems, you must have administrative privileges. For information regarding
privileges, please refer to the operating system Help.

On most computers, Picture It! setup will begin automatically when you insert
the Picture It! CD into your CD-ROM drive.

To begin automatic setup:

1 Turn off any antivirus software that you’re using, and close any programs
that are running.

2 Insert the Picture It! CD into your CD-ROM drive.
The Installation Wizard begins automatically.

If the above procedure does not start the setup process, you can start it manually.

To begin setup manually:

1 Turn off any antivirus software that you’re using, and close any programs
that are running.

2 Insert the Picture It! CD into your CD-ROM drive.
3 Click Start, and then click Run.
4 If your CD-ROM drive is listed as letter D, type d:\setup.exe

If your CD-ROM drive has a letter other than D, replace D with the
correct letter when you type the path.

5 Click OK.
The Installation Wizard begins.
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Completing the Installation Wizard
The Installation Wizard will show you a series of dialog boxes that provide
setup status and some installation preference options. For most users, the
default preferences will be appropriate. Information about the different setup
options is provided below.

Installation Folder Dialog Box
The Installation Folder dialog box allows you to choose where the program will
be installed on your computer. To install the program to a different folder than
the folder in the Installation folder box, do one of the following:

■ Type a different path in the Installation folder box.
■ Click Change, select a folder in the Change Installation Folder dialog

box, and then click OK.

Note that some files will be installed to the Program Files drive even if you
choose to install the program to a different drive.

Installation Options Dialog Box
The Installation Options dialog box allows you to choose between Typical
installation and Full installation.

■ Typical installation takes up less space on your hard drive, and is
recommended for most users. With Typical installation, you will have to
insert the Picture It! CD in your CD-ROM drive to use some of the
projects and clip art while you are using the program.

■ Full installation copies all of the Picture It! projects and clip art to your
hard drive, so you will not have to reinsert a Picture It! CD while you are
using the program. Look under Description in the Installation Options
dialog box for the disk space required for this option.
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Special Circumstances

Upgrading from a Different Picture It! Product
If you already have a Picture It! product installed on your machine, several
scenarios may occur when you try to install another Picture It! product:

■ Previous versions If you have a Picture It! product previous to version
7.0 already installed, installing a version 7.0 product will make both
programs available on your computer.

■ Upgrade from another version 7.0 product You can install a Picture It!
version 7.0 product that has more features than a version 7.0 product
already installed. The version of Picture It! with fewer features will be
uninstalled automatically, but your pictures and projects will not be
deleted.

■ Blocked downgrade If you have a Picture It! version 7.0 product
installed, you will not be able to automatically install a version 7.0
product with fewer features. To install the version with fewer features,
you must first uninstall the version with more features.

Reinstalling or Removing Picture It!
If you are having problems running Picture It!, reinstalling the program may
help it to run better on your computer.

You should not attempt to remove Picture It! by deleting the program files from
your hard disk. Instead, use the Picture It! Installation Wizard to properly
uninstall the program.

Other Picture It!
Products
The family of Picture It!
products includes
programs with the
following brands:

■ Digital Image Pro

■ Greetings

■ Greetings Workshop

■ Home Publishing

■ Picture It!

■ Picture It! Express

■ Picture It! Photo

■ Picture It! Publishing
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To remove or reinstall Picture It! on Windows XP:

1 From the Windows Start menu, click Control Panel.
2 Click Add or remove programs.
3 From the list of installed programs, click the version of Picture It! you

want to remove or reinstall.
4 Click Change.

The Installation Wizard opens.
5 Follow the instructions on the screen.

To remove or reinstall Picture It! on Windows 98,
Windows 2000, or Windows Me:

1 From the Windows Start menu, point to Settings, and then click Control
Panel.

2 Click Add/Remove Programs.
3 From the list of installed programs, click the version of Picture It! you

want to remove or reinstall.
4 Click Add/Remove.

The Installation Wizard opens.
5 Follow the instructions on the screen.
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No matter how polished and creative you are as a photographer, Picture It! is a
valuable tool for helping you get the most out of your photos. With Picture It!
features, you can easily correct common photo problems such as red eye and
overexposure. And you can use features like filters and layers to create photos
strikingly different from your originals.

Although Picture It! is a powerful photo-editing program, it’s important to get
the best photo you can at the time you take it. Picture It! can do a lot to correct
minor problems with the originals, but certain problems, such as severely
blurred or underexposed photos, cannot easily be fixed with computer software.
And if you can develop your photography skills to take higher-quality photos,
you can spend your time doing creative photo editing with Picture It!, rather
than fixing mistakes that can be avoided.

The extreme blurriness and lighting problems of this photo would be difficult—if not impos-
sible—to overcome with image-editing software.

Many cameras available today offer a high degree of automation: just turn the
camera on and press the shutter, and the camera does the rest. While this
approach is quick and easy, it isn’t perfect in all situations. As a photographer,
you can learn to fine-tune the settings on your camera to gain greater control of
the camera to get the best possible photo for each situation.

With the range of cameras available—from basic point-and-shoot models to
professional SLR (single-lens reflex) cameras—this chapter cannot cover specifics
for all features available on all cameras. But this chapter does provide a foundation
of photography concepts that are vital to taking consistently good photographs.

Opening photos
from your digital
camera
For information on
opening photos from
your camera in Picture
It!, see the digital
camera section in
chapter 3, “Opening
Photos in Picture It!”
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The first section of this chapter contains information specific to digital cam-
eras: concepts such as resolution and compression that don’t have direct
counterparts in film photography. Later sections cover universal photography
concepts that apply to both film and digital cameras.

About Digital Cameras
If you’re new to using digital cameras, several camera features may seem
foreign to you. Some of these features, such as digital zoom and compression,
did not exist with film cameras because the technology did not exist. But it’s
important to understand what these features do and when it’s appropriate to use
them (or, in some cases, not use them).

Photo Quality
A digital photograph is composed of tiny colored squares called pixels (short
for picture elements). Like a mosaic, the pixels blend together to form a picture.
Each digital photo consists of a set number of pixels, ranging from a few
thousand to millions. When a digital camera takes a photo, it creates a digital
file that specifies the number of pixels and the precise color of each pixel.

Pixels are not a set size, so they can shrink or enlarge if photo size changes.
When a photo is enlarged too much, the individual pixels become visible,
making a poor-quality photo.

The original photo on the left was saved at high resolution, and you can see sharp detail. The
photo on the right has been saved at such low resolution that you only see the individual
pixels.
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The number of pixels that make up a photo is the photo’s resolution. Resolution
and compression are key factors in determining the quality of a digital photo.
The following sections explain resolution and compression.

Resolution

Resolution is one of the main determinants of photo quality since it is a
measure of the total number of pixels that make up a photograph. Resolution is
sometimes expressed as the total number of pixels, such as 3 megapixels (3
million pixels), or in pixel dimensions, such as 320 x 240 (which equals 76,800
total pixels).

Resolution is important primarily because it determines how much you can
enlarge and print a photo. Everything else being equal, a 3-megapixel photo
and a 320 pixel x 240 pixel photo look the same in a wallet-size print. But if
you enlarge those two photos to 5” x 7” prints, the quality of the 320 x 240
photo is very low: you can see the individual pixels. The 3-megapixel photo
still looks sharp at the larger size, since its pixels are too small to be seen.

Resolution is also important because it determines file size. High-resolution
photos contain color information for many more pixels than low-resolution
photos, so the files for high-resolution photos can be significantly larger. File
size becomes an issue if you have limited storage on your camera or hard disk,
or if you need to send the photos through e-mail.

The following chart gives an estimate of file size and maximum print size for
various resolutions. The chart lists file sizes for JPEG format, which is a
common (but not the only) format for photos.
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Approx. JPEG file size
Dimensions Total pixels (with slight compression*) Maximum print size

320 x 240 76,800 23 KB Wallet size

640 x 480 307,200 91 KB 4” x 6”

1280 x 960 1,228,800 363 KB 5” x 7”
(1.2 megapixels)

1600 x 1200 1,920,000 576 KB 8” x 10”
(1.9 megapixels)

2,048 x 1,536 3,145,728 970 KB 11” x 14” and larger
(3.1 megapixels)

* Compression, which is explained in the following section, varies by camera, so you may find
different file size results.

Instead of film, a digital camera uses an image sensor—usually a CCD (charge-
coupled device) or CMOS (complementary metal oxide semiconductor) chip—
to capture the visual information when you take a photo. The image sensor on a
simple, low-resolution camera might capture just over 76,000 pixels. The image
sensor on a high-quality digital camera might capture more than 6 megapixels.
As you can imagine, the 6-megapixel camera can produce very large, high-
quality photos (with very large files). The 76,000-pixel camera can capture a
relatively small number of pixels, so photo quality would be fair to poor, even
at small print sizes.

On many cameras, you can set the resolution at which the image sensor
captures the photo. As a rule of thumb, always shoot at the highest resolution
possible—you’ll get higher-resolution photos that you can print in larger sizes.
However, in some cases you may want to lower the resolution so that the files
will be smaller. This allows you to store more photos on the camera’s storage
media, but you must sacrifice some quality for quantity.

Make sure to check your camera’s manual to find out what resolution you will
get from the photo-quality settings on your camera. Beware of settings that
offer “enhanced” or “interpolated” resolution. These features add extra pixels
not found in the original photo to produce a higher-resolution photo, but may
reduce overall sharpness or quality.

Megapixel rating
One of the main
factors in the price of a
digital camera is its
megapixel rating. The
megapixel rating
indicates the maximum
number of pixels (in
millions) that are
captured by the
camera’s image
sensor.
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Compression

You’ve seen one way to reduce photo file size: lower the resolution at which
you shoot the photo. You can also reduce file size by having the camera
compress the photo file as it saves the file to the camera’s memory. Compres-
sion consolidates similar information in the photo, and discards some informa-
tion. With JPEG compression, for example, series of similarly colored pixels
are grouped together and considered to be the same color. In the code that
makes up the file, the color information for these grouped pixels only has to be
listed once instead of hundreds, or even thousands, of times. This shortcut can
reduce file size considerably. Taken to extremes, a photo in highly compressed
JPEG format might be 95 percent smaller than the same photo in an
uncompressed format.

Although compression does reduce file size, it also reduces photo quality.
Slight to moderate compression might not noticeably reduce photo quality, but
high compression produces visible areas of splotchy color called artifacts. Even
with slight compression, artifacts become more pronounced each time the
photo is saved and compression is applied.

The left photo has been saved with lossless compression, so all of the image quality is
retained. The photo on the right was saved with heavy JPEG compression—which is not
lossless—and the compression significantly reduced the image quality.

File size and
photo quality
Lowering resolution
and increasing
compression both
reduce file size and
photo quality. Bearing
this in mind, you can
use file size as a rough
way to judge photo
quality.
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For important photos that you want to make into prints, it’s good practice to use
little or no compression. Or, if your camera offers it, you can take your photos in
a format, such as TIFF, that offers lossless compression. Lossless compression
reduces file size, but retains all of the photo quality.

File Formats
There are many file formats designed for photos or other digital images. Picture
It! can work with JPEG, TIFF, and many other file formats. If your camera
allows you to choose file formats for your photos, you can decide which format
to use based on your particular criteria: photo quality, file size, or compatibility
with other programs.

The JPEG format is the most common format for photos. JPEG files are
versatile, since they can accommodate over 16 million colors, can be com-
pressed, and can be viewed in any Web browser. To reduce file size, the JPEG
format always uses compression, although the degree of compression varies by
camera. Experiment with the compression settings on your camera to find a
low-compression setting that produces good or excellent results. Because JPEG
uses some compression every time a file is saved, many photo purists prefer
formats like TIFF over JPEG.

The TIFF format provides an extremely accurate recording of digital-image data.
Some cameras can use a lossless compression method with TIFF. But even with
some compression, TIFF files are generally larger than JPEG files for photos
with the same resolution. For example, a single uncompressed 5-megapixel
TIFF image is larger than 10 MB. To work with photos of that size, you need a
lot of memory on your computer, as well as a high-volume storage disk.

File formats
compatible with
Picture It!
Picture It! can open
photo files in any of the
following formats:

Adobe Photoshop
(.psd)

AutoCAD (.dxf)

CorelDraw (.cdr)

Enhanced Metafile
(.emf)

EPS (.eps)

FlashPix (.fpx)

GIF (.gif)

Home Publishing (.php)

JPEG (.jpg)

Kodak Photo CD (.pcd)

Macintosh PICT (.pct)

Micrografx Designer
(.drw)

PC Paintbrush (.pcx)

Picture It! (.php, .mix,
.fpx)

PNG (.png)

TIFF (.tif)

Targa (.tga)

Windows Bitmap
(.bmp)

Windows Metafile
(.wmf)
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Using Zoom Features
A zoom lens lets you adjust the focal length of the lens, making your subject
appear closer to or farther from the camera. Some cameras have built-in
adjustable zoom lenses; others accommodate interchangeable zoom lenses of
different focal lengths.

Digital cameras may offer optical zoom or digital zoom. An optical zoom
feature uses the same principle as a zoom lens on a film camera: the lens itself
moves to change the focal length. In any of the zoom positions, the resulting
resolution is the same.

A digital zoom feature does not move the lens. Instead, the software inside the
camera crops the photo to make the subject appear closer. Because the pixels
are removed from the area that’s cropped out, the overall resolution is lower.
Many cameras offer a combination of optical and digital zoom. For best results,
use only optical zoom. Then, if necessary, use Picture It! to crop the photo.

Both “digital zoom” and “enhanced resolution” features use interpolation to
add pixels to the original photo, a process that increases the overall size or
resolution. Interpolation assigns colors to the added pixels based on the colors
of the surrounding pixels. While these features technically do increase resolu-
tion, they do not achieve the same photo quality as a photo that has not been
interpolated. If your camera has digital zoom or enhanced resolution, test it and
make sure you like the results before you use it for important photographs. For
true zoom capability and highest image quality, use optical zoom.

Memory Cards, Disks, and Sticks
After the image sensor captures a photo in your digital camera, the digital
information is stored on removable media, such as a CompactFlash or
SmartMedia card, a memory stick, a floppy disk, a CD, a microdrive, a minia-
ture storage card, or a secure multimedia card.

Floppy disks and CDs have the advantage of being inexpensive and easy to

Expand your
perspective
Zoom lenses are great
for capturing objects
you can’t get close to,
such as a ship sailing
in water far from the
shore. Use a zoom lens
to get candid close-up
shots of people without
seeming intrusive or
conspicuous.
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find, even if you’re traveling abroad. Floppy disks, however, have very limited
storage capacity.

Memory cards are small, durable, and reusable. And storage technology has
been steadily improving, so you can now find cards that store as much as 1
gigabyte (GB). Memory cards can be reused over and over, which, over time,
makes them less expensive than film.

Buying additional storage media, like these CompactFlash cards, allows you to take many
more photos in a single session.

Storage media size dictates how many photos you can store. The media that is
included with some cameras can only hold a few high-resolution photos. This
type of low-capacity card can be impractical for situations such as traveling. To
give yourself more flexibility, you may want to purchase additional removable
storage media.

Battery Life
Compared to film cameras, many digital cameras use batteries at a surprising
rate. The LCD preview screen and the flash on the camera both put a heavy
drain on the batteries. And unlike some manual film cameras, digital cameras
cannot function without batteries or an AC power adapter.

The best recharge-
able batteries
Lithium-ion batteries
and nickel metal
hydride (NiMH)
batteries both work
very well with cameras,
providing power and
convenience.
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To ensure longer shooting, you can buy rechargeable batteries, which last
longer than disposable alkaline batteries. Keep your spares charged so they’ll
be ready when you need them. If you are running low on power and don’t have
a spare battery, conserve remaining power by trying the following:

■ Turn off your LCD screen and compose through the viewfinder.
■ Turn off your flash so that it doesn’t fire automatically. Turn the flash on

only when you really need it.
■ Wait until you’re home to preview your photos.

Using the Flash
Learning to use the flash is one of the easiest ways to get better photos both
indoors and outdoors. Especially when you’re photographing people, overpow-
ering light from the flash can ruin the shot, often in ways that are difficult to
correct with photo-editing software.

Most inexpensive and moderately priced cameras come equipped with a built-
in flash. The flash may be programmed to fire automatically when the camera
senses that the flash is needed. But relying on the camera’s judgment will not
always give you the best results. Built-in flashes can create harsh shadows,
overexposed areas, and unnatural-looking light.

Read your camera’s manual to learn what the recommended flash range is, and
to find out how to adjust different flash settings. Three of the most common
flash settings are outlined in the following sections.

Upgrading your
flash
If your camera
supports an external
flash, consider buying
one, especially if you
take a lot of indoor
photos of people. An
external flash will give
you much more control
and often better
results.

The range of your
flash
Check your camera’s
manual to find out the
recommended range
for your flash. Most on-
camera flashes are
designed to illuminate
a subject that is 10 to
15 feet from the
camera. If the flash is
too close, your subject
may look too bright or
washed out in the
photo. If you’re too far
away, the flash doesn’t
provide enough light.
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No Flash
Contrary to what you might think, you may be better off without your flash in
many situations. If you think the scene is too dark to take without a flash, try
increasing the ambient light by turning on lamps and opening the drapes. On
most digital cameras, you can increase the ISO equivalent setting, in effect
making the image sensor more sensitive to the available light, which allows
you to shoot in low light without a flash.

Many newer cameras offer low-light shooting modes and night-flash settings
that improve the quality of low-light photos. If your camera offers these options,
use them. Otherwise, always stay within the recommended range of the flash.

Red-Eye Reduction Flash
One of the most common problems with flash photos of people and pets is red
eye. This problem is caused by a flash located very close to the camera lens.
The light from the flash reflects off the blood vessels in the subject’s retina,
causing the pupils to look red. This problem occurs frequently in low-light
situations, when pupils are likely to be dilated. There are several things you can
do to help avoid red eyes in your photos:

■ Increase the ambient light in the room. Turning on lights and opening up
the drapes reduces the size of your subjects’ pupils.

■ Use your camera’s red-eye reduction setting. This feature fires preflash
bursts that help reduce the dilation of the pupils before the exposure.

■ If you have an off-camera flash, move it away from the camera lens.
Then, even if your subjects’ pupils are dilated, the light comes from a
different angle, and reduces or eliminates the red-eye effect.

Fixing red eye with
Picture It!
If you end up with red
eyes in your photos,
Picture It! makes it
very easy to remedy
this problem. For more
information, see the
section on removing
red eye in Chapter 5,
“Basic Touchup.”
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Fill Flash
You can use the fill flash setting to fill in deep shadow areas caused by bright
overhead sunlight, or in a scene where the light is behind the subject.

       

In the left photo, the strong backlighting creates a shadow that covers the subject’s whole
face. For the photo on the right, fill flash was used to counteract the backlighting and keep the
shadows off the subject’s face.

If your flash is using the automatic setting, bright daylight can prevent it from
firing. Turn on the flash manually, or, if your camera has a fill-flash setting,
turn it on. If you see shadows on your subjects’ faces as you’re composing the
shot, fill flash is a good idea.

An alternative to using the fill flash is moving to a different place where the
light from the sun is diffuse and indirect, which produces a softer, more
flattering portrait light.

Using Your Camera’s Manual Settings
In today’s camera marketplace, the lines between manual and automatic
cameras have become blurred. It used to be that manual cameras were 35mm
SLR (single-lens reflex) cameras with manual controls for focusing, aperture,
shutter speed, and film speed. On the other end of the spectrum were fully
automatic cameras with very limited controls, possibly only a shutter button.
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For serious camera users, the manual SLR cameras were usually the best
option, since they offered so much control. The creative process was not left to
the automatic settings of a camera. Automatic point-and-shoot cameras were
good for novice photographers who didn’t want to worry about setting the
camera controls. Many automatic cameras could produce adequate or even
excellent photos without requiring knowledge of advanced photography
concepts.

While you can still find fully automatic and fully manual cameras, many of
today’s cameras offer different modes for different degrees of automatic and
manual control. For example, some SLR film cameras let you switch to an
automatic mode where the camera determines everything from focusing to
setting the aperture. Many compact digital cameras are designed to be used
primarily in automatic mode, but also allow you to switch to program and
manual modes to control exposure settings, like shutter speed and aperture.

With digital cameras, the adjustments that you make are often digital approxi-
mations of the equivalent function in film cameras, as with shutter speed or
ISO. But the photographic result is the same. The following sections provide an
overview of the most important manual camera settings and concepts.

Exposure
Exposure describes the amount of light that comes into your camera when you
take a photo. Setting the camera to the correct exposure is crucial to getting the
proper tones and colors in your photos. Overexposure occurs when too much light
has reached the image sensor (or film in a film camera), which decreases detail
and causes the photo to look washed out. Underexposure occurs when insuffi-
cient light has been let into the camera, and the photo looks dim and murky.

Exposure is controlled by three factors: the aperture, the shutter speed, and the
ISO rating. Aperture is the size of the opening that lets light into the camera.
Shutter speed is how long light is allowed into the camera. ISO rating (the film
speed in a film camera) is the sensor or film’s sensitivity to light.
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The water glass analogy

When taking a photograph, your goal is to achieve a perfect exposure. To create
the right exposure, you need to understand the relationship between the three
exposure factors: aperture, shutter speed, and ISO rating. Achieving perfect
exposure can be compared to filling a glass completely without spilling any of
the water. For a perfect exposure, the glass should become completely full with
no water spilling over. In this analogy, the tap symbolizes the aperture: the
wider the tap is open, the faster the glass fills up. The time that the tap is open
represents the shutter speed: leaving it open longer lets more water into the
glass. To fill the glass to exactly the right level, the rate of flow must be set
according to the time the tap is open.

The third factor, ISO rating, can be equated to the size of the water glass. A
smaller glass, representing a faster ISO rating, fills up more quickly than a
larger glass, representing a slow ISO.

Understanding automatic exposure

As a photographer, you will come across a wide range of lighting conditions,
and each condition requires that you adjust your camera to different exposure
settings. For example, shooting a photo on a beach on a sunny day calls for
different exposure settings than shooting on the same beach on a cloudy day.

For many conditions, the camera’s automatic exposure setting gives you good
or even excellent results. But for some situations, the automatic exposure does
not perform as well.

Automatic exposure assumes that the scene you are photographing has a few
bright spots, many midtones, and a few dark areas. As the camera’s meter reads
the available light in your scene, it averages the light in the bright, middle, and
dark areas, and then calculates the exposure necessary to bring the average
level to a tone of medium brightness called middle gray.
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Automatic exposure does not work well if your scene is dominated by large
sections of very light or very dark colors. A bright field of snow, for example,
has so much bright light that the automatic exposure lowers the brightness until
the snow looks gray. To work around this shortcoming, you can use exposure
compensation.

Exposure Compensation
Some cameras have an exposure compensation feature that lets you manually
override the automatic exposure setting. Exposure compensation lets you adjust
the exposure with settings such as +2, +1, -1, and -2. A +1 setting, for example,
tells the camera’s automatic exposure system to make the middle tones brighter.
When taking a photo dominated by bright snow, increasing the exposure with
the +1 setting might correct the light level for the snow-filled scene. Your
actual results will vary according to your camera and the brightness of the day.

With bright snow in a scene, setting your camera’s exposure compensation setting to +1 or +2
may help you to get the right exposure.

Aperture
The aperture is the opening through which light passes to reach the film, or, in
digital cameras, the image sensor. Aperture is measured by f-number, where a
specific setting is called an f-stop. With f-stops, a low number, such as f/4,
represents a wider opening that lets in more light. A small aperture, such as f/
16, lets in significantly less light.

Increasing your
chances with
bracketing
If you’re not sure what
the best exposure
setting is, try bracket-
ing. Bracketing
involves taking
multiple photos of the
same scene. Start by
using the automatic
exposure, and then
use exposure compen-
sation to take addi-
tional frames with
increased and
decreased exposure
levels. With a series of
photos taken at
different settings,
there is a good chance
that one has the
exposure just right.
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Some cameras have a fixed aperture that can’t be adjusted. If you’re adjusting
the aperture yourself, a setting of f/8 is a good place to start, since it gives you a
fairly wide zone of sharpness.

If your camera allows you to adjust the aperture, use the settings to regulate the
depth of field in your photo. Depth of field refers to the zone in your photo that
is in acceptably sharp focus. A wide aperture gives you a shallow depth of field,
while a small aperture allows a very deep zone—maybe even everything in the
photo—to be in focus.

Imagine pointing your camera down a set of railroad tracks which go all the
way to the horizon. With a wide aperture, like f/2.8, if you focus on a railroad
tie a short distance away, only a few of the other ties are in sharp focus. With a
narrow aperture, like f/22, many more of the ties are in focus, even those quite
a distance from your main focal point.

      

A wide aperture will give you a short depth of field, as illustrated in the photo on the left,
where only a limited range of the tulips are in focus. The photo on the right was taken with a
small aperture, so almost all of the tulips are in focus.

For portrait photography, a wide aperture helps to limit the focus. Your
subject’s face is clear and sharp, but objects in the background are blurred. But
if you’re shooting a vacation photo of someone posing in front of a monument,
a narrow aperture may be in order. With the narrow aperture, both the person
and the monument can be in focus in the same photo.

Program modes
If your camera offers
program modes for
specific photos like
portraits or action
shots, read your
camera’s manual to
find out the aperture
settings used for those
modes.

Shutterless
cameras
Many digital cameras
do not have a true
shutter. Instead, the
image sensor is
programmed to control
the exposure time. The
effect of shutter speed
control is the same as
a physical shutter.
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Of course, adjusting the aperture also affects how much light is let into the
camera. But if a specific depth of field is important for your shot, you can
switch to manual mode, set the aperture, and then set the shutter speed to get
the correct exposure level. Some cameras also offer an aperture priority mode
that automatically selects the correct shutter speed to produce the correct
exposure for the aperture you select.

Shutter Speed
In most cameras, the shutter is the curtain in front of the film or image sensor
that is retracted for a precise amount of time to let light into the camera. Shutter
speed can be adjusted to let light into the camera for a longer or shorter amount
of time.

When determining the correct exposure for a photo, both shutter speed and
aperture must be considered in relation to each other. An increase in shutter
speed, which lessens the time the film is exposed to light, requires that you
widen the aperture to let in more light.

Shutter speeds are measured in fractions of seconds. In automatic mode, many
cameras will use a shutter speed of about 1/125th of a second. For action
photography, a very fast shutter speed, like 1/500th of a second, can help to stop
action and reduce blurring caused by movement of your subject.

A fast shutter speed like 1/250th of a second can help you freeze action.
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At the other extreme, you might set the shutter to stay open for four seconds, or
even more for low-light night photography without a flash. But shutter speeds
slower than 1/30th of a second increase the likelihood that slight movements in
your hand while you take the shot will cause a blurred photo. To avoid camera
shake, mount your camera on a tripod or other firm surface for slow shutter
speeds.

To accommodate the low light of this twilight scene, the camera was mounted on a tripod and
set to a slow shutter speed.

Some cameras offer a shutter priority mode that sets the aperture automatically
after you set the shutter speed. This can be useful if you’re in a situation where
shutter speed is more important than aperture, like when you’re shooting a
subject in motion.

ISO Setting or Equivalent
When shooting on film, you have the opportunity to select different types of
film for specific uses. Films are available in different speeds that are more
sensitive or less sensitive to light.

ASA versus ISO
If you have an older
camera, the film speed
dial might be labeled
ASA instead of ISO.
These film speed
ratings are the same,
and the ratings are
interchangeable.
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The film speed is measured by ISO number. A high-speed film, such as ISO
800, is ideal for low-light situations or action photography, since the film
requires less light to properly expose the photo. Slow-speed films, such as ISO
100 or ISO 200, are good for photographing in bright daylight, since they
require a lot of light. If you plan on using the same roll of film for shooting in
multiple settings and light levels, ISO 400 film is a good compromise and does
relatively well in most situations.

Faster films generally produce grainier photos than lower-speed films. Some of
the newer varieties of professional grade high-speed films produce a finer grain
structure, which is less noticeable.

Since digital cameras use an image sensor instead of film, there is no way to
actually change the film speed. However, many digital cameras provide the
digital equivalent of an ISO. Sometimes called the sensitivity setting, this
feature allows you, in effect, to change the ISO setting. For example, if you are
shooting in a low-light situation, you can switch from ISO 100 to ISO 400.

With most digital cameras, setting the digital equivalent of the ISO setting to a
faster speed can introduce noise to the photo. Similar to the graininess from
high-ISO film, noise is random pixels in the photo that are slightly off-color or
too bright. Cameras vary widely, so it is worthwhile to experiment with your
digital camera’s ISO settings and examine the results.

In low-light situations, consider turning off the flash and setting the camera to a
faster ISO setting. This may produce some noise in the photo. But that result
might be preferable to what you’d get by taking the photo at slower ISO setting
with the harsh lighting of the on-camera flash.

Setting the White Balance
Most digital cameras are automatically programmed to calculate the proper
white balance for each exposure. To calculate the white balance, the camera
assumes the lightest spot in the picture is white, and adjusts the other colors
accordingly. Under most circumstances, this automatic function should prevent
an off-color cast in your photos.

Avoid sharpening a
photo with noise
Do not to use the
sharpen feature in
Picture It! on digital
photos with noticeable
noise; sharpening
accentuates the
inaccurate pixels.
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However, in some lighting conditions, the camera fails to correctly set the
white balance. If you’re shooting indoors, for example, incandescent lights give
off a yellowish or reddish glow. This color is not really visible to the naked eye,
but often shows up in indoor photos. To counteract this problem, most digital
cameras have preprogrammed color balance settings that compensate for
different kinds of light. Typical settings include cloudy, shade, incandescent,
flash, fluorescent, and sunny. These settings compensate for the different colors
of light likely to be present in those conditions, and should produce photos that
require little or no color correction. Read your camera’s manual to find out
about specific white balance settings it offers.

With film cameras, there is no way the camera itself can compensate for
different lighting conditions. But there are two ways you can compensate for
the colored light:

■ Use film designed for specific lighting situations. Tungsten-balanced
films, for example, help to neutralize the color of tungsten or halogen
illumination.

■ Use a filter on your camera lens. For example, if you’re using daylight-
balanced film but want to shoot indoors, you can use a blue-colored filter
to absorb the overriding yellows and reds of the indoor incandescent
lights.

Using Automatic Modes on Your Camera
Many of the automatic cameras sold today—even some of the less-expensive
models—have pre-programmed modes that are designed for special situations.
Sometimes called program modes, these modes automatically adjust your
camera to special settings designed specifically for things like macro photogra-
phy, action shots, portraits, panoramic mode, or picture series.

If you’re a beginning photographer who is not always confident enough to
adjust your camera’s manual settings, use the automatic modes to help you take
better photos.

Correcting tint in
Picture It!
If your photo has a
colored cast from a
light source, correct
the problem with the
Picture It! tint tool.

Setting the white
balance manually
Some digital cameras
offer manual white
balance control. This
feature allows you to
set the white balance
by focusing on a pure
white object, such as a
piece of paper, and
then locking down the
white balance before
you take the photo.
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If your camera does not allow you to adjust settings manually, the automatic
modes may be the most likely way for you to take successful photos in these
situations.

The following sections describe the most common automatic modes available
on many digital and film cameras. Since the type and implementation of
automatic modes vary for each camera, read your camera’s manual for avail-
ability and usage instructions.

Macro Mode
Most cameras in automatic mode have trouble focusing on objects that are less
than 12 inches (30 centimeters) away. So when you’re shooting close-up
photography, like capturing a special piece from your coin collection, you need
to set your camera to macro mode. Macro mode adjusts the focal length to
accommodate the unusually short distance to the subject.

Macro mode usually reduces aperture, which widens the depth of field, and
increases the chances that the whole subject is in focus.

The camera’s macro mode was used to capture the fine detail of the jewelry.
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When using macro mode, make sure to turn off the flash, since the flash does
not provide proper illumination at such close range. Tripods are a good way to
keep the camera steady for a close-up shot. If you don’t have a tripod, set the
camera on a firm surface, focus the photo, and then activate the shutter with the
self-timer. This way, your hand does not have to touch the camera and acciden-
tally introduce any movement to the shot.

Action Mode
If you’re photographing subjects such as athletes, moving cars, or even fast-
moving children, a camera’s action mode helps keep your subject in focus. The
most significant characteristic of action mode is the faster shutter speed of at
least 1/500th of a second, which helps to freeze the action of your moving
subject. The action mode in most cameras also uses a wider aperture setting (to
offset the fast shutter speed), and multipattern light metering, which compen-
sates for overly bright and overly dark areas.

Action mode uses a fast shutter speed to freeze the action of a fast-moving subject.

Digital cameras create a unique challenge for shooting action photography: the
time lag between pressing the shutter button and the actual exposure. With film
cameras, pressing the shutter button causes the shutter to open virtually
simultaneously. But with digital cameras, you might have to wait as long as
four seconds before the photo is taken. When shooting moving objects, four
seconds can seem like an eternity.

When the lag is a
drag
Some digital cameras
have a much shorter
shutter lag than
others. Consider this
factor when buying
your next camera.
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One way to compensate for the shutter lag is to anticipate your shot. Imagine
you are photographing a runner with a camera that has a four-second shutter
lag. (The four-second shutter lag will not be highlighted on the camera’s
packaging, but you can figure it out through your own experience.) First, focus
your camera on a spot that the runner will cross in about 10 seconds. When the
runner is only four seconds away from your target spot, press the shutter
button. The exposure should occur just as the runner comes into your field of
focus.

Another way to shoot a moving subject is to pan your camera with the action.
While a stop-action photo freezes everything in the photo, panning your camera
keeps your moving subject in focus, but blurs the background. For this effect,
you do not want to use the action mode, because you do not want a fast shutter
speed. To accomplish this effect, follow your moving subject in the viewfinder
(or LCD screen) as it moves, but pan the camera so that your subject remains in
the same position in the frame. Your result won’t show the subject in as clear a
focus as stop action, but the blurred background helps to pronounce the speed
and movement of your subject.

Since the camera panned with the subject, the girl is in fairly sharp focus and the background
is blurred. This technique helps convey movement.
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Burst Mode
Burst mode is a feature that allows you to take a series of photos in quick
succession. Most cameras’ burst modes allow you to take 10 to 15 photos in 5
to 15 seconds.

Even on digital cameras with slow shutter lags, the burst mode still allows you
to take many frames in a short time span. The burst feature uses a buffer to
temporarily hold the information from the image sensor. After the set of 10 to
15 frames is stored in the buffer, the camera processes each frame separately
and sends them to the removable storage media.

If your camera has a burst mode feature, you can use it to overcome the
slowness of the shutter lag. When photographing a child, for example, it can be
hard to get the child to pay attention for the few seconds that it takes to shoot
the photo. But with burst mode, you might be able to shoot 10 frames within 10
seconds. During that 10 seconds, you can encourage the child to talk, look at
the camera, and make different movements and expressions. It’s doubtful that
all 10 exposures will turn out to be great photos, but you’re much more likely
to get at least one good shot than if you’d just taken a single frame.

    

Another great use of the burst mode feature is to take a photo series of an action
sequence. Create a series of photos of a golf swing, a child riding a bike, or a
pet moving across the yard. Then you can assemble the whole series in a slide
show, or mount the photos together in a frame.
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Portrait Mode
For portraits and candid shots, using your camera’s portrait mode is a conve-
nient way to get good results. Portrait mode is set to use a relatively wide
aperture, creating a shallow depth of field. With only your subject in focus,
objects in the background are less distracting, and your subject dominates the
frame.

With a shallow depth of field, it’s crucial that you get your subject in sharp
focus. If your depth of field is so short that you can’t focus on every part of
your subject at the same time, focus on the subject’s eyes, and let hands and
feet be in less focus.

For this portrait, the diffuse glow filter was applied in Digital Image Pro to soften the focus.

For successful portraits, remember to fill the frame, and use a slightly telephoto
lens, such as a 105mm, or a slight zoom setting. Keep the background very
simple, unless you are using objects in the background as context for your
subject. If shooting indoors, an off-camera flash or other light source works best.

Relaxing your
subject
An important aspect of
portrait photography is
to get your subject
relaxed and comfort-
able for the pose. Try
using conversation or
other pleasant
distractions to get your
subject’s mind away
from the camera.
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Panoramic Mode
For landscapes, large groups of people, and other long horizontal shots, a
camera’s panoramic mode helps you compose the photo without too much sky
or ground in the photo. Panoramic shots have a different aspect ratio than
standard shots, meaning the width of the frame is proportionally much greater
than in a photo with a standard aspect ratio.

Some panoramic cameras take photos with an aspect ratio of 4:11 (four units
tall by 11 units wide), compared to the aspect ratio of 3:4 for standard shots on
most digital cameras. As with the shape of a movie theater screen versus a
television screen, the wider frame gives you some new creative territory when
composing your photo.

   

Switching your camera to panoramic mode gives you new compositional possibilities.

True panoramic cameras use a wide-angle lens to let you capture more width of
the scene by staying in the same position. Many cameras, including digital
cameras and APS cameras, offer a panoramic mode without a wide-angle lens.
Instead, the panoramic effect is achieved by simply cropping off the top and
bottom of the frame. This type of panoramic shot does give you a wider aspect
ratio, but not a wider angle. On some digital cameras, using the panoramic
mode means that each photo has fewer pixels (since the top and bottom are
cropped), so each panoramic shot takes up less space on your storage media.
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Using the Self-Timer
Many digital cameras, even inexpensive ones, come with a self-timer feature.
Some self-timers open the shutter after a preset amount of time, such as 10
seconds; others allow you to adjust the length of time before the shutter fires.
Either way, this fairly simple feature is great for getting yourself into a photo
and taking long exposure shots.

Getting Yourself into a Photo
To get yourself into a photo, plan where you want to position yourself for the
shot. Then set up the camera by putting it on a tripod, a table, or any other flat,
stable surface. With your camera in position, focus the camera on your subject,
which should be close to the position where you will stand for the photo.

If your camera has autofocus, press the shutter halfway down to focus, press
the self-timer button, and then press the shutter all the way down. Then you’ve
got about 10 seconds to get yourself in position for the shot.

Taking Long Exposure Shots
Another great use of the self-timer is for exposures with a relatively slow
shutter speed. For speeds slower than 1/30th of a second, there is a good chance
the slight movements in your hands will cause blurriness in your photo. Even if
you have very steady hands, the slight movement of your finger pressing the
shutter button can create movement. Using the self-timer will eliminate this
problem. By setting the camera on a firm surface and using the timer, your
hands don’t have to be anywhere near the camera while the shutter is open.

Creating a
makeshift tripod
If you’re outdoors, try
propping the camera
on a rock or car roof.
Then fine-tune the
positioning by putting
the camera on a jacket
or other object that you
can shape to adjust
the camera angle.
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Ten Tips for Great Pictures
The following 10 tips offer suggestions for developing your photography
approach, technique, composition, and habits. If you are an inexperienced
photographer, some of these tips might be new ideas for you. If you’re a
photography veteran, these tips might be a good reminder of things you haven’t
heard in a while. Either way, we hope they inspire you to get out and shoot
some great photos!

1. Know Your Gear
Having command of your equipment is an important aspect of enjoying and
being successful with photography. As you get to know your gear and gain
confidence in a camera’s capabilities, the camera can become an extension of
yourself. When you have reached this level of competence, you can concentrate
more on the creative aspects of photography.

When you get a new camera, first read through the manual. With digital
cameras especially, operating the controls may not be intuitive, since many
digital cameras’ controls must be accessed through menus on the LCD screen.

After you’ve read the manual, and you understand how and when to use your
camera’s features, go out and take a variety of photos using the different
settings. Take some photos outdoors and indoors, with the flash and without the
flash, with automatic settings and with manual settings. As you shoot, take
notes to record the settings used for each shot. Later, look at your photos on
your computer, and take note of both the settings that worked well and the
settings that produced poor results.

Missing a great photo because you get hung up on technical issues is frustrating.
Spend time getting to know your gear, and prepare for great photo opportunities.
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2. Nail the Exposure
In a finished photo, exposure is something that you usually only notice when it
is out of adjustment. A perfect exposure is not something that jumps out at you
from a photo, but a problem exposure definitely stands out. In an overexposed
photo (caused by too much light), the shadow areas are light, and the highlight
areas are almost entirely white. In an underexposed photo, too little light has
been let into the camera, creating a photo that lacks detail, with filled-in
shadow areas and dull highlighted areas.

Special lighting situations can fool the built-in light meter in your camera. If
you want to start with the camera’s automatic exposure, use exposure compen-
sation to fine-tune the exposure. The following list describes some common
lighting problems and the recommended exposure compensation for each:

■ For a side-lit subject: Increase exposure by one-half of a stop.
■ For a backlit subject: Increase the exposure by one stop. Or step in close

and meter directly on the subject, step back and recompose, and then
shoot at the reading you took on the subject. You can also switch to spot
metering.

■ For a small dark subject against a bright background, or any subject in a
very bright scene: Use exposure compensation of +1 to +3, or increase
exposure by one to two stops, for example, from f/8 to f/5.6 or f/4.5.

■ For a small, light subject against a dark background: Use exposure
compensation of -1, or decrease exposure by one stop, for example, from
f/8 to f/11.

3. Capture a Moment in the Story
Consider driver’s license and passport photos. We think of these photos as
uninteresting and unrepresentative of how people usually look. Why are these
photos dull?

Planning for the
imperfect
Learning to nail the
exposure takes a lot of
experience, and no one
gets it right with every
shot. If you suspect the
lighting might make it
difficult to nail the
exposure, you can
increase your chances
of success by bracket-
ing, as explained in
tip #7.
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One problem (but certainly not the only problem) with these photos is that they
capture people out of their element, without context or a story. There are no
interesting details in the background to draw in the viewer, and the subject
often looks impatient or uncomfortable.

When you are the photographer, you can strive to capture people, events, and
places that tell a story. In addition to having your subject look natural and not
posed, details in front of the subject or in the background can stimulate the
imagination to re-create the story of the photo.

This photo captures the destruction of an earthquake just hours after the event. Because the
photo was taken before the rubble was cleared away, the photographer was able to capture
the many details of the scene that tell the story.

With enough of these details, and a strong relationship between your subject
and the other elements, the photo can suggest ideas that are not even in the
frame. You can take the old cliché “A picture paints a thousand words,” and
make it your goal to paint more than a thousand words with your photographs.

4. Look for the Light
Many of the best photographs are taken early in the morning, late in the
afternoon, and at twilight. At these times the lighting is most dramatic.
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Many photographs are shot in bright or moderately bright sunlight. This type of
light produces photos that closely match the way we remember seeing the
scene. That is part of the reason we respond to them with a positive sense of
familiarity.

However, colors photographed in the cooler light at twilight or in overcast
conditions, or in the warmer light of sunrise and sunset, offer a new perspective
on familiar colors and subjects, and provide a more creative backdrop for
photographs. Overcast and after-the-rain conditions, in particular, produce
richer, more saturated colors. For example, red leaves photographed against a
twilight backdrop, instead of in daylight, create a moody interpretation that
suggests a sense of mystery or drama.

In the dim light of a rainy fall day, the red leaves in this photo look especially vivid.

For interior photographs, look for strong sources of natural light, as from a
window or a skylight. The glow of light coming from one direction can
illuminate your subject dramatically.
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5. Follow the Rule of Thirds
When composing a photograph, many beginning photographers always center
their subject directly in the middle of the frame. While this technique may be
the easiest way to get the subject in focus with a point-and-shoot camera, it is
not always the most interesting way to present the subject.

To apply the rule of thirds, divide your scene into three sections horizontally and vertically.
Place the focal point of your photo on one of the intersections of the dividing lines.

Most advanced photographers follow the rule of thirds when composing the
space inside a picture frame. The rule of thirds divides the frame into thirds
both horizontally and vertically, and places the point of interest on one of the
four spots where these dividing lines intersect. The rule of thirds is used
throughout the graphic design world, because it helps to create balance between
the subject and the background.

Following the rule of thirds, the bicycle in this photo lies right on one of the points where the
dividing lines intersect. The top of the dock also roughly follows the horizontal line that runs
one-third down from the top of the frame.

Recomposing a
photo with
Picture It!
After a photo has been
transferred to your
computer, use the crop
tool in Picture It! to
change the composi-
tion. By removing the
edges of the photo, you
can reposition your
subject to comply with
the rule of thirds.
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If you have a person or animal in your photo, you can place the subject’s face
on one of the four points, looking toward the center of the scene. If the horizon
is in a photo, it should run about one-third from the top or one-third from the
bottom, depending on whether the terrain or the sky is the center of focus.

The rule of thirds is not an absolute law, and there have been many great
photographs taken that don’t abide by it. But the rule can be a great way to add
balance and interest to your photos.

6. Find a Unique Perspective
Challenge yourself to take original photos that convey unique perspectives.
Rather than just pressing your shutter button as soon as you have the urge to
capture a scene, take some time to assess your shooting angle, proximity to your
subject, and background elements. You may transform your composition by
taking one or more of the following simple steps:

■ Get closer to your subject, to show more detail and eliminate distractions
in the background.

■ Include just a portion of your subject in the frame.
■ Take your original subject and place it in the background. Find a new

subject that adds context to the object in the background.
■ Get lower to the ground, and point the camera up toward your subject.
■ Move to a higher location, above your subject, so you are pointing down

when you take the photo.

For example, if you are traveling, your natural instinct might be to take
straightforward photos of local monuments. But with this approach, you might
wind up with the same lackluster photos taken by scores of other tourists before
you. And there would be a good chance that a nearby souvenir shop would sell
superior, professionally photographed prints and slides of the same monuments.
For that matter, you could have just stayed home and ordered the professional
photos from a catalog.
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Use your imagination to compose some original, creative photos that you won’t
find anywhere else. Capture some of the local color by photographing a lively
food vendor stationed near the monument, and the monument can be the
backdrop in your frame. Or use the self-timer to capture you and your compan-
ion sampling the local fare that you’ve bought from the food vendor in front of
the monument.

7. Bracket
The term bracket means to create exposures that are both lighter and darker
than the camera or light meter indicates. The idea is to second-guess the purely
mechanical exposure meter, so that you get the right exposure.

If you’re taking photos of a sunset, a scenic vista, or a plant, you have the time
to bracket. With these subjects, you’re also likely to have a wider range of tones
to record than your camera can handle, especially if your subject is brightly lit.

So how do you bracket with an automatic camera? Most digital cameras, and
many automatic cameras, have an exposure compensation feature, sometimes
called the EV setting. If you set the exposure compensation for -1, the shot is
one stop underexposed (darker than normal). If you set the camera for +1, the
shot is one stop overexposed (lighter than normal). So you can bracket by
taking three photos, one each at the -1, 0, and +1 settings.

Some cameras offer an automatic feature, which takes a range of photos, each
with a different exposure setting.

Even if your camera doesn’t permit you that much control (or if you don’t want
to take the time to change the exposure settings), another technique will give
you results similar to bracketing. To get a lighter exposure, aim your camera at
a darker portion of the subject, and then press the shutter button partway down
(until you begin to feel a little resistance). Next, without releasing pressure on
the shutter button, reframe your photo to include what you want, and then push
the shutter button all the way down to take the photo.

A quick check with
the LCD
One of the benefits of
digital photography is
that you can get a look
at your photos on the
LCD preview screen
right after you’ve taken
the shot. This feature
is great for a quick
analysis of the photo’s
composition, exposure,
and color tone. Just be
aware that since the
preview screen is so
small, it often does not
reveal problems with
focus.
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Depending on your camera, pressing the shutter button halfway down may lock
in the exposure and the focus. If this is the case, you need to set the exposure
on an object that is exactly the same distance away from the camera as the
subject. Otherwise, your subject will not be in focus when you take the photo.

8. Analyze and Shoot Again
Photography takes practice. And you will progress at a faster rate if some of
your practice time is focused on developing specific skills. One way to do that
is to analyze your photos, and then go shoot them again.

When you get a chance to look at your photos on a computer or as prints, you
can assess their quality of composition, lighting, exposure, and white balance.
Upon close inspection, you might realize that you placed your subject too close
to the center of the frame, or that incandescent lights caused an orange glow.
On your next shoot, go out and take this same photo again, and make adjust-
ments for the problems you encountered before.

When you look at the results of your second round of photos, you may find that
you got excellent results, or you may find that one of your adjustments dis-
rupted something else in the photo. Or maybe the different lighting conditions
of the different day made it more difficult to nail the exposure.

To continue the exercise, shoot the same subject or scene on a regular basis.
You must always compensate for the differences in lighting each day, but you
can try new approaches to the composition. Learning to shoot the same subject
under different conditions or with a different approach gives you valuable
experience and ideas when you encounter new situations.
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9. Shoot Every Single Day
To become a talented and confident photographer, make photography part of
your daily routine. Fortunately, digital cameras have made it much more
convenient and inexpensive to shoot lots and lots of photos. Once you’ve
purchased your digital camera, you can take as many photos as you want. The
only cost is for batteries and storage for your photos.

The more you practice, the more confident you’ll become in your skills and in
your equipment. You’ll also develop the habit of keeping your camera close by,
and having it ready for photo opportunities. Train yourself to look for these
opportunities, and take advantage of them when they come to you. Some of the
world’s most memorable photos were taken by amateur photographers who
happened to be in the right place at the right time. So to be ready to take that
once-in-a-lifetime shot, know how to use your gear, have your equipment
handy, and be on the lookout for great photo material.

10. Show Your Photos to Other People
Even when you are making great progress with your photography skills, it’s
easy to overlook the shortcomings in your own work. To continue improving
your abilities, show your photos to other people. Getting others’ opinions is an
invaluable learning experience.

Good photos should be visually exciting to people, eliciting a “Wow, this is
great!” response. If you find that people are not very excited by your photos,
ask them what they think is missing, and what you could do to make them
better. You’ll be surprised what some people like and do not like about your
photos.
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Find other photographers in your community. You can look at each other’s
work and give feedback. This kind of mutually beneficial arrangement also
helps you to develop your critical eye.

A Web-based photo site such as MSN Photos makes it convenient to share your
photos with lots of other people, both your local connections and distant family
and friends.

While it’s important to show your photos to others, remember that you are the
ultimate judge of your own work. Photography is an art, and as an artist you
should establish your own voice and style. You don’t have to listen to every
piece of advice, and you may produce your best work by taking chances and
following your own instincts.

That said, photographs are made to be seen! As you improve your photography
skills, showing off your photos can be the best part.
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Using the File Browser
In most cases, you can use the file browser to locate your photos and open them
in Picture It!. The file browser can be used to open photos from:

■ A digital camera that is a USB Mass Storage Class device. (A USB Mass
Storage Class device works as a “virtual drive,” letting you browse and
open photos from the device as you would from a hard disk or floppy
disk.)

■ A digital photo card reader.
■ The hard drive on a computer.
■ A CD or DVD.
■ A floppy disk.

Opening photos
from other
cameras
If your camera is not a
USB Mass Storage
Class device, see the
section later in this
chapter, “Opening
Photos From a Digital
Camera or Card
Reader.”
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This picture identifies the main features of the file browser:

1 2 3

6

4

8

5

97 10

1 Folders tab  Click the Folders tab to see the folder structure on your
computer. Click a folder to display its contents and subfolders. The folder
structure includes internal and external drives on your computer, includ-
ing disk drives, card readers, and USB Mass Storage Class digital
cameras.

2 Tasks tab  Click the Tasks tab to perform batch-editing tasks such as
rotating and renaming.

3 Look in box  Displays the name of the current folder selected on the
Folders tab.

4 View menu  Use this menu to change the way the image files are
displayed.

5 Thumbnail size slider  Move the slider to change the size of the thumb-
nails.

6 File name box  Displays the file name of a selected thumbnail.
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7 Files of type menu Use this menu to change the types of image files to
be displayed.

8 Thumbnails Small versions of your photos stored in the current folder.
9 Open Opens the selected thumbnails.

10 Cancel Closes the file browser without opening any photos.

The file browser provides a quick view of the photos on your compatible
camera or card reader, and allows you to open the photos directly without using
additional programs.

To open the file browser:

■ On the File menu, click Open.

Opening Photos From a Digital Camera
or Card Reader
Many newer digital cameras are USB Mass Storage Class devices, which allow
the computer to read the photo files on the camera as a “virtual drive.” Other
cameras use TWAIN or WIA support as a way for the camera to transfer
information to the computer.

If your camera or card reader can function as a USB Mass Storage Class
device, you can connect it to your computer and select the photos as you would
from a CD or disk drive.

About TWAIN
and WIA
TWAIN is interface
software that allows
communication
between a camera and
your computer. Many
digital cameras come
with a TWAIN driver.

WIA is a newer
interface that works
similarly to TWAIN, but
often provides more
control over the device.
WIA is compatible with
TWAIN, but is available
only on some computer
operating systems.
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To open photos from a camera or card reader that is a
USB virtual drive:

1 Make sure your camera or card reader is turned on and connected to your
computer.

2 On the File menu, point to Get Picture From, and then click Digital
Camera.

3 Under Click a camera or drive, click your camera or card reader.
4 Click Download.

The File Browser dialog box opens, displaying the photos on the camera
or card reader.

5 Click a photo. To select more than one photo, press CTRL while you
click the photos.

6 Click Open.

If your camera does not show up as a drive in the file browser, it is probably
designed to work using TWAIN or WIA support. Picture It! works with TWAIN
and WIA and your camera’s software so that you can open photos into Picture
It!.

To open photos from a TWAIN- or WIA-compliant camera:

1 Make sure that you have installed all the drivers and software that came
with your camera.

2 Connect your digital camera to your computer, and then turn on the
camera.

3 On the File menu, point to Get Picture From, and then click Digital
Camera.

4 Under Click a camera or drive, click a camera.
5 Click Automatic Download.
6 Click Download.

The photos stored on the camera are displayed in the workspace.
7 Click Download all pictures.

- or -
To open individual photos, drag photos from the workspace into the Tray.

8 Click Done.

Using your
camera’s software
Some digital cameras—
especially older
models—may not
function as a virtual
drive or be TWAIN-
or WIA-compliant.
For these cameras,
use the software
provided by the
camera to download
the photos to a folder
your computer, and
then open them in
Picture It!.
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Scanning a Photo
Picture It! works with your scanner’s software so that you can scan directly by
using the Picture It! scanner task.

To scan a photo with a flatbed scanner:

1 Make sure the scanner drivers are installed and the scanner is connected
and turned on.

2 Lift the scanner lid, place the photo face down on the scanner surface,
and then close the scanner lid.

3 On the Picture It! File menu, point to Get Picture From, and then click
Scanner.

4 Select the options you want. If you are scanning on a flatbed scanner, and
your version of TWAIN or WIA supports Automatic Scan, click Auto-
matic Scan. Otherwise, click My scanner software.

Opening a Photo From Your Computer
Picture It! is compatible with many different image file formats. The sidebar on
this page lists the different types of files that Picture It! can open.

Some imaging programs automatically will, by default, save photos to the My
Pictures folder inside the My Documents folder. Other programs and cameras
might save your photos within a folder named for the program or camera.

File formats
compatible with
Picture It!
Picture It! can open
photo files in any of the
following formats:

Adobe Photoshop (.psd)

AutoCAD (.dxf)

CorelDraw (.cdr)

Enhanced Metafile
(.emf)

EPS (.eps)

FlashPix (.fpx)

GIF (.gif)

Home Publishing (.php)

JPEG (.jpg)

Kodak Photo CD (.pcd)

Macintosh PICT (.pct)

Micrografx Designer
(.drw)

PC Paintbrush (.pcx)

Picture It! (.php, .mix,
.fpx)

PNG (.png)

TIFF (.tif)

Targa (.tga)

Windows Bitmap (.bmp)

Windows Metafile
(.wmf)
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To open a photo stored on your computer’s hard disk:

1 On the File menu, click Open.
The File Browser dialog box opens.

2 Click the Folders tab.
3 Browse through the folders to locate the photos you want. When you

click a folder, you can see thumbnails of the photos in that folder.
4 Select a photo. To select more than one photo, press CTRL while you

click the photos.
5 Click Open.

Opening a Photo From a Photo CD or Other Disk
You can use the file browser to open photos from a photo CD or other disk.

To open a photo from a photo CD or other disk:

1 Insert the CD or disk into the appropriate drive in your computer.
2 On the File menu, click Open.

The File Browser dialog box opens.
3 Click the Folders tab.
4 Click the name of the disk drive you want.
5 Select a photo. To select more than one photo, press CTRL while you

click the photos.
6 Click Open.

Finding the correct
drive letter
A CD-ROM or DVD drive
is usually drive D under
My Computer. A floppy
disk drive is usually
drive A.
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Opening a Photo Sent Through E-mail
Many friends and family members enjoy sending photos through e-mail. When
you receive photos through e-mail, you can save them to your computer and
then work on them with Picture It!.

Many photos sent through e-mail are low-resolution photos, which are not
suitable for large prints. But low-resolution photos may be fine for online
viewing or printing at small sizes.

To open a photo sent through e-mail in Picture It!:

1 Use your e-mail program to save the photo to a folder on your computer.
Save the photo to a folder that will be easy for you to locate later, such as
the My Pictures folder.

2 In Picture It!, click Open on the File menu.
The File Browser dialog box opens.

3 Click the Folders tab.
4 On the Folders tab, browse to the folder containing the photo, and then

click the folder.
5 Select the photo, and then click Open.

Opening a Photo from a Web Page in Picture It!
When you surf the Internet, you may come across photos and other images that
you would like to use in your photo projects. You might find photos of celebri-
ties, vacation spots that you want to visit, or graphics that would look good as
part of one of your photo projects. Unless the Web site uses image protection,
you can capture these images and use them for your own projects. Web images
are usually low resolution, so they may not be suitable for printing. But you
could still use the images in a project to be viewed online.

Can this photo be
printed?
To find out if a photo
has enough resolution
to print, see “How large
a print can you get” in
Chapter 12, “Printing
Photos.”

Watch for
copyrights
Pictures you see on the
Web may be copy-
righted, so make sure
to read the site’s legal
information before you
use an image.
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To capture an image from a Web page, you can drag it from the Web page to the
Picture It! Tray.

To open a photo from a Web page in Picture It!:

1 Make sure both Picture It! and your Web browser (either Microsoft
Internet Explorer or MSN Explorer) are open and running on your
computer.
A button for each program is in the taskbar along the bottom of the
screen.

2 In your Web browser, locate the Web page that contains the photo you
want.

3 Click the photo, hold down the mouse button, and drag the photo down to
the Picture It! button on the taskbar. Pause on the Picture It! button.
The Picture It! window opens.

4 Drag the pointer to the Picture It! Tray.
The photo appears in the Tray and on the canvas.

Once the photo is opened in Picture It!, you can edit it as you would any other
photo and save it to your computer.

Opening a Photo from MSN Photos
MSN Photos is an online photo Web site that enables you to share and organize
photos, as well as order prints and gifts. Picture It! and MSN Photos are
designed to be used together, with MSN Photos offering services and informa-
tion only available on the Internet. Many of the features of MSN Photos can be
accessed directly from Picture It!.

Saving images
from a Web site
When saving an image
from the Web, make
sure to click Save AsSave AsSave AsSave AsSave As
on the FileFileFileFileFile menu so
you can specify the
folder where the image
is saved. Otherwise,
the image may be
saved in a temporary
Internet files folder.

Signing up with
Microsoft .NET
Passport
To use MSN Photos,
you must have a
Microsoft .NET
Passport. All
hotmail.com and
msn.com e-mail
addresses are .NET
Passports. If you don’t
yet have a .NET
Passport, it’s free to
sign up, and you can
get to the sign-up page
by following the
instructions for saving
to MSN Photos.
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After you have uploaded photos to the MSN Photos Web site, you can open
them from any computer with Internet access. In Picture It!, you can download
photos directly from MSN Photos to edit on your computer.

To open a photo from MSN Photos:

1 Make sure that your computer is connected to the Internet.
2 On the File menu, point to Get Picture From, and then click MSN

Photos.
3 Follow the instructions on the screen.

When you have finished editing the photo in Picture It!, you can save it to your
computer or back to MSN Photos.

Using MSN Photos
For more information
about MSN Photos,
see the sections on
MSN Photos in the
following chapters:

■ Saving Photos

■ Sharing Photos

■ Printing Photos
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This chapter covers the fundamental aspects of Picture It! that you’ll need to
get started. You’ll find information on the Startup Window, the work area, basic
image manipulation, applying text, and Help resources.

Startup Window
The Startup Window is a quick launching point to photos, projects, tasks,
recently opened files, and Help.

By default, the Startup Window opens every time you start Picture It!. After
closing the Startup Window, you can open it at any time from the main work
area by clicking the Startup Window button  in the Common Tasks list. This
picture identifies the main features of the Startup Window.

1

6 8 97 10

2 3 4 5

1 Open Click the Open button to open the file browser, where you can
open photos from your hard disk, a network drive, a digital photo card
reader, a CD or DVD, or a floppy disk.

2 Import from Camera Click this button to open the digital camera task,
so you can download photos from a digital camera using Picture It! or
your camera’s software.

3 Scan a Picture Click this button to open the Scan Picture task, where
you can scan a picture directly into Picture It!.
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4 Edit Multiple Pictures Click this button to open Mini Lab, where you
can perform routine editing tasks—such as rotating, levels auto fix,
cropping, and saving—on multiple photos at the same time.

5 Create a Project Click this button to pick a project design. You’ll find a
variety of projects—such as calendars, greeting cards, and album pages—
designed to work with your photos. Projects are organized by type and by
theme.

6 Show on startup check box Select this box to have the Startup Window
open every time you start Picture It!.

7 The Help Center The Help center links you directly to resources to help
you with Picture It! and digital imaging.
■ Picture It! Tour launches the product Tour.
■ Instructional Videos displays links to the different videos available.
■ Help opens the online Help window.
■ Online Photo Tips links you directly to the Tips & Tricks section of

the MSN Photos Web site.
■ Register Online links you to the registration page of the Microsoft

Web site.
8 Recent Files Displays thumbnails of the last four photos that you have

opened. Click a thumbnail to open that photo.
9 More Files Click More Files to open the file browser, where you can

open photos from your hard disk, a network drive, a digital photo card
reader, a CD or DVD, or a floppy disk.

10 Close Click to close the Startup Window and go to the main work area.

Examining the Work Area
Most of the photo-editing tasks you perform in Picture It! will be in the main
work area. This picture identifies the key elements of the Picture It! work area.

Getting Help
See the Help
Resources section
later in this chapter for
more information on
the Picture It! Tour,
Instructional Videos,
and online Help.
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1 2 3

7

4

8

5 6

9

1 Common Tasks list 6 Stack
2 Canvas 7 Tray
3 Workspace 8 Zoom tool
4 Menu bar 9 Pan control
5 Toolbar

Common Tasks list
The Common Tasks list is an easy way to locate features. This list provides
convenient access to some of the most common Picture It! tasks, as well as
single-click access to Mini Lab, project selector, and the Startup Window. All
of the features found in the Common Tasks list—and some additional fea-
tures—are also available in the menus.

If you use the Common Tasks list frequently, you can leave it in its expanded
state. Or, to maximize the size of the workspace, you can collapse the Common
Tasks list so that it only shows an icon for each of the tasks.

To expand or collapse the Common Tasks list:

■ On the View menu, click Common Tasks.
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Canvas
The white area is called the canvas, and it represents the printable area of the
page. When you open a photo, the canvas is often not visible because it is
covered entirely by the photo. You can use the zoom controls to magnify or
reduce the canvas so that it covers more or less of the workspace.

Workspace
The gray area represents the workspace, the area surrounding the canvas.

Menu bar
Menus provide access to all of the Picture It! features. The Help menu gives
you access to the Help window, the Instructional Videos, and the Picture It!
Tour.

Toolbar
The toolbar contains shortcut buttons for single-click access to some of the
most common commands. To see the name of a toolbar button, move the
pointer over the button.

Stack
The Stack displays a thumbnail to represent each layer in your photo. You can
rearrange the order of the layers by dragging a thumbnail up or down within the
Stack. You can also use the Stack as a precise way to select objects that are very
small or hidden behind other objects. You can select multiple objects on the
Stack by holding down CTRL as you select them.

Tray
The Tray displays thumbnails of all open projects. You can switch your active
project by clicking a thumbnail in the Tray. You can also add a project to the
current project by dragging the thumbnail from the Tray to the canvas.

Zoom controls
The zoom controls magnify or reduce your photo so that you can see it in more
or less detail. There are five zoom controls available:

Expanding the
workspace
Minimizing the
Common Tasks list will
increase the size of the
workspace, letting you
see more of your
picture while you work.
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■ The zoom percentage control displays the size of the canvas in the
workspace, expressed as a percentage of its actual size, such as 50, 100,
or 200 percent. To change the view size, type a new percentage in the
box, and then press ENTER.

■ The Zoom to entire page button  magnifies or reduces the canvas so
that its largest dimension fits just inside the workspace.

■ The Zoom to page width button  magnifies or reduces the canvas so
that its width fits just inside the workspace.

■ The Zoom to selection button  magnifies or reduces the selected object
so that its largest dimension fits just inside the workspace. This button is
useful when you want to edit just one object in a composite.

■ The slider control  lets you quickly zoom in or out from 1 to
999 percent of actual size. You can drag the slider for fine tuning, or just
click a spot on the slider to zoom in or out quickly. You can also click the
minus (-) or plus (+) buttons to zoom in or out at preset intervals.

The zoom controls do not increase or decrease the resolution of a photo; they
simply control how large a photo looks on the screen.

Pan control
The pan control displays a thumbnail of your active project. When your photo
is enlarged so that the canvas is larger than the workspace, a box appears on top
of the thumbnail. This box represents the part of the picture that is viewable
inside the workspace, and you can drag this box on the thumbnail to view a
different area of the picture. As you zoom in on the canvas, the box becomes
smaller; as you zoom out, the box becomes bigger.

You can drag the box on top of the pan control to move your picture around inside the
workspace.
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Basic Image Formatting
When a picture is on the canvas, you can manipulate the image to a different
size or orientation. You can make many of these changes directly on the canvas
by dragging the different handles on a picture. All of these controls can also be
accessed through the menus.

Changing picture size
When you open an image so that it appears on the canvas, it is automatically
sized so that it fills the workspace. As a result, a high resolution image, such as
1600 x 1200 pixels, will look as large as a low resolution image that’s only 640
x 480 pixels. For this reason, viewing a picture on the canvas is not a reliable
way of judging an image’s resolution.

When you change a picture’s actual size (not just zooming in on the canvas),
you change the number of pixels in the image. If you have a high resolution
photo that you want to post to a Web site, you might want to make the picture
smaller so that it will be transmitted faster over the Internet. In this situation, as
long as you won’t need to print the image, you can safely reduce the image size
(the number of pixels that make up the image) and still have an image that
looks good on the screen.

To resize a picture:

1 On the Format menu, click Resize Image.
2 Click an orientation.
3 Click an image size. To see the size expressed in different units, click a

selection on the Units list. If you click Custom, you can enter custom
dimensions in the Height and Width boxes.

4 Click a resolution, and then click Done.

Choosing a
resolution
While resizing an
image, select a
resolution appropriate
for its intended use.
For high quality
printing, choose 300
dpi; for Web and
e-mail, choose 72 dpi.
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Manipulating Objects by Using Object Handles
Each element you add to a picture on the canvas is considered an individual
object. Photos, text, clip art, and even some effects are all considered separate
objects, and they can be edited individually. When you’re working with a
composite, which consists of multiple objects on the canvas, you can manipu-
late each object without affecting the other objects.

Each object on the canvas is a separate layer, and each layer is represented by a
thumbnail on the Stack. You can change the order of layers by dragging them
up and down the Stack.

Selecting objects

When you select an object, you can edit it without affecting other objects on the
canvas. You can select an object by clicking it, either on the canvas or on the
Stack. If you want to select a small object or one that is hidden behind other
objects, it is often easiest to select it on the Stack.

You can tell when an object is selected because it will be bordered by a
selection box, a dashed-line rectangle surrounding the selection. Around the
edges of the selection box are yellow circles are called object handles, which
are used for moving and resizing the object. There are two types of object
handles:

■ Resize handles Resize handles are located on the corners and along each
edge of the selection box. Use the corner resize handles to resize a picture
proportionally. Use the top, bottom, or side resize handles to stretch a
selection box.

■ Rotate handle The rotate handle is attached to the top of the selection
box. Use the rotate handle to rotate a picture clockwise or counterclock-
wise.

Use object handles to rotate, resize, and stretch an object.

Centering an
object on the
canvas
To center the object on
the canvas, on the
FormatFormatFormatFormatFormat menu, click
Center Object onCenter Object onCenter Object onCenter Object onCenter Object on
CanvasCanvasCanvasCanvasCanvas.
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By default, the object handles are visible every time you select an object, but
you can set them so they are not visible.

To show or hide object handles:

■ On the View menu, click Object Handles.

Moving an object on the canvas

Objects can be moved around on the canvas to change the way your composite
is arranged.

To move an object on the canvas:

1 Select the object.

2 Hold the pointer over the object until the move handle  appears, and
then drag the object.

Resizing an object

When you resize an object, you can resize it proportionally, maintaining the
ratio between height and width.

These two objects were originally the same size. A corner resize handle was dragged outward
on the right object, resizing it proportionally.

Resizing to fit
the page
You can automatically
resize an object to fill
the whole canvas On
the Format Format Format Format Format menu,
point to Resize ObjectResize ObjectResize ObjectResize ObjectResize Object
to Fit Canvasto Fit Canvasto Fit Canvasto Fit Canvasto Fit Canvas, and then
click a resize option.
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To resize an object:

1 Select the object you want to resize.
2 Hold the mouse pointer over one of the corner resize handles until the

resize handle  appears.
3 To resize the object from the center point of the object, press CTRL.
4 Drag the resize cursor.

Stretching an object

When you select an object, you can stretch it by moving one of its top, bottom,
or side resize handles. The top and bottom resize handles stretch the object
taller or shorter, and the side resize handles stretch it skinnier or wider. As with
resizing an object, holding down the CTRL key stretches the object around the
center point of the object.

The top, bottom, and side resize handles stretch an object out of proportion. The original
object is on the left. The center object was stretched taller with the top resize handle; the right
object was stretched wider with a side resize handle.

To stretch an object:

1 Select the object you want to stretch.
2 Hold the mouse pointer over one of the side resize handles until the resize

cursor  appears.
3 To resize the object from the center point of the object, press CTRL.
4 Drag the resize cursor.
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Rotating an object

The rotate handle lets you rotate an object by dragging it around its center axis.

By dragging the rotate handle clockwise or counterclockwise, you can rotate objects right on
the canvas.

To rotate an object:

1 Select the object you want to rotate.
2 Pause the pointer over the rotate handle until the rotate cursor  appears.
3 Drag the rotate handle clockwise or counter-clockwise.

Selecting multiple objects

If you want to perform the same formatting or editing tasks on several objects,
you can select them and treat them as a unit. Multiple selection is a temporary
way of linking objects.

To select multiple objects:

■ Press CTRL, and then select each object on the Stack.

After you have selected multiple objects, each object’s object handles appear,
and a selection box appears around the set of selected objects. The multiple
selection icon  appears at the bottom of the selection box.

Setting snap
rotation
Snap rotation helps
you rotate your objects
to exact 45-degree
increments. To turn
snap rotation on or off,
on the ToolsToolsToolsToolsTools menu,
click Snap RotationSnap RotationSnap RotationSnap RotationSnap Rotation.
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These three objects are a multiple selection, as indicated by the icon at the bottom of the
selection box. The objects can now be edited as a set and then separated later.

While the objects are a multiple selection, you can use the objects’ object
handles to edit them as a set. You can edit the objects together by using touchup
tools or applying effects. Clicking outside any of the selected objects cancels
the multiple selection, leaving intact any changes you have made to the set.

Grouping objects

To join objects more permanently, you can group them. Grouping works
similarly to multiple selection, although once the objects are grouped, they
appear as a single object on the Stack. You can perform editing tasks simulta-
neously on grouped objects, but if you later ungroup the objects, some effects
that you applied to the group will be undone.

To group objects:

1 Press CTRL, and then select each object in the Stack.
2 On the Edit menu, click Group.

Once objects are grouped, the group icon  appears at the bottom of the
selection box.

Grouping shortcut
You can group and
ungroup objects that
have been multiple
selected by clicking
the   or  icon
at the bottom of the
selection.
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These three objects have now been grouped, as indicated by the group icon at the bottom of
the selection box. Grouping objects lets you edit the objects as a set if you don’t plan to
separate them later.

To ungroup objects:

1 Select the group of objects you want to ungroup.
2 On the Edit menu, click Ungroup.

After you ungroup a set of objects, they will remain multiple selected until you
click in the workspace outside the selection.

Adding Text
You can add text to any picture and easily change the text’s font, font color,
font size, alignment, and emphasis. You start by adding a text box, and then you
edit the text in the box. A text box is its own layer in the Stack.

To add text:

1 On the Text menu, click Insert Text.
A text box appears.

2 Type your text. As you add text, the text box automatically expands
vertically to fit all of your text.

3 To change the width of the text box, select the text box and drag one of
the side resize handles.

4 To move the text box, select it, pause the pointer over the edge of the text
box until the move handle appears, and then drag the move handle.

Adding text to your
project
You can add text to any
photo, giving it a title, a
caption, or comments
about the picture. You
can also change the
default text and
messages in Picture It!
projects.



Microsoft Picture It! Companion Guide

65Chapter 4: Picture It! Basics

After the text has been added, you select the text to edit it. You can also select
the text and use the toolbar buttons to change formatting. If text is selected, the
following tools are available on the toolbar for formatting:

■ The font menu  provides access to 126 different fonts.

■ The font size menu  provides access to sizes from 8 to 620 points.
■ The font color button  offers a standard palette of colors and custom

colors.
■ The Bold button  adds bold formatting to the text.
■ The Italic button  adds italic formatting to the text.
■ The Underline button  underlines the text.
■ The Alignment button  has menu choices for Left, Right, Center, and

Justify.
■ The Bullets and Numbers button  enables you to apply or cancel

formatting for bulleted or numbered lists.

Help Resources
You can learn more about using Picture It! through a variety of resources. In
addition to this Companion Guide, there is the online Help system, the product
Tour, and Instructional Videos. The following sections describe the types of
information available.

Online Help
Picture It! online Help is the most comprehensive of the Help resources. It
provides step-by-step instructions, overviews, troubleshooting topics, access to
technical support, and the “What’s wrong with this picture” diagnostic tool.
Help includes several ways to find information, including a table of contents, a
keyword index, and a full-text search.

Getting Help from
the keyboard
You can open the
online Help system at
any time by pressing
F1 on the keyboard.
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This picture identifies the main features of the Help window.

1 4

6

2 3 5

7 8 9

1 Show/Hide button Click this button to expand or collapse the left pane
of the Help window.

2 Back button Click this button to go back to the last Help topic.
3 Options menu This menu has options to print a topic or to set options

such as Internet Options, where you can change the font size in the Help
window.

4 Content pane displays the current Help topic.
5 Close button closes the Help window.
6 Contents tab displays the Help table of contents.
7 Index tab lets you find keywords in the index list.
8 Search tab finds topics that contain words that you enter.
9 Favorites tab lets you save topics for quick access later.

To access online Help:

■ On the Help menu, click Microsoft Picture It! Help.
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Using the table of contents

You can use the table of contents to locate information by subject. The table of
contents is a useful way to see all of the features available in each category of
features.

To use the table of contents:

1 In the left pane of the Help window, click the Contents tab.
2 To expand a book in the contents, click the plus sign next to it.
3 To display a topic, in the contents list, click the topic title.

Using the index

You can use the index when you are looking for information about a specific
term or keyword.

To use the index:

1 In the left pane of the Help window, click the Index tab.
2 In the Type in the keyword to find box, type the word you want to find.
3 In the results list, select the word you want to find, and then click

Display.

Using the search function

You can use the search function to find all the topics in Help that contain a
word or combination of words.

To use the search function:

1 In the left pane of the Help window, click the Search tab.
2 In the Type in the keyword to find box, type the word for which you

want to search, and then click List Topics.
3 In the Select topic to display list, select the topic you want to view, and

then click Display.

Picture It! Tour
The Picture It! Tour uses pictures and text to demonstrate popular features and
new features of the program.
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To take the product tour:

1 On the Help menu, click Picture It! Tour.
The Tour opens, displaying icons to represent different categories of
features.

2 Click an icon.
A feature list appears on the left side of the window.

3 Click a feature.
Graphics and text appear that explain the feature.

4 If more features appear to the right of the feature you’ve selected, roll
over the features to see the effect.

5 Repeat steps 2-4 to learn about more features.
6 To close the Tour, click Close.

Instructional Videos
Instructional Videos use animation and narration to show you how to use a
variety of image-editing features on your photos.

To watch an Instructional Video:

1 On the Help menu, click Instructional Videos.
The Help window opens to a topic about Instructional Videos.

2 Click a video title link.
The Video player opens and the Video begins.

The Instructional Videos are accompanied by complete, online tutorials that
include sample photos on which you can practice. To open the online tutorial,
click the Written Tutorial button on the Video player.

Technical Support
Different Technical Support resources are available based on where you live
and how you obtained your Picture It! product.

To view Technical Support information:

1 On the Help menu, click About Microsoft Picture It! 7.0.
2 Click Tech Support.
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Almost all photos can be improved with basic touchup. Picture It! touchup
tools can be used to correct common photo problems such as red eye or lighting
problems, and similar distractions that can ruin a photo. In many cases, Picture
It! helps you eliminate basic problems with just a few clicks.

Touchup tools can, in many cases, help compensate for problems with expo-
sure, lighting, or composition. Touchup tools can even hide flaws such as
blemishes or stains on clothing.

Adjusting Brightness and Contrast
When you take a photo with an automatic camera, the camera’s automatic
exposure feature measures the available light and determines how much light is
required to take the photo. Sometimes, the exposure meter’s measurement is
too low or too high, creating problems with brightness and contrast in the
photo. Picture It! provides tools to fix the levels of brightness and contrast.

 To correct brightness and contrast:

1 On the Touchup menu, click Brightness and Contrast.
2 Click Levels auto fix.
3 If you are not satisfied with the result, click Contrast auto fix.
4 If you are not satisfied with the result, fine-tune the settings with the

Brightness and Contrast sliders.
5 Click Done.

The photo on the left is both too dark and too low contrast. The levels auto fix tool was applied
to the version on the right, correcting both the brightness and contrast levels.

Making a copy to
touch up
Never edit one of your
original photos. Always
make a copy and edit
only the copy. Then if
you later decide that
you don’t like how the
edits turned out, you
can start again by
making another copy
from the original.
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Adjusting Tint
When you take photographs, the source of the light can create a colored cast in
the photo. We tend to think of light being white, but nearly every light source
has its own unique color. For example, natural sunlight has more blue in it,
while incandescent (tungsten) lights—including most household light bulbs—
give off a reddish or yellowish cast.

When taking a photo, you can compensate for these different colors of light by
setting the white balance (with a digital camera), or using special filters (on a film
camera). But if you still end up with a cast in your photos, use the adjust tint tool
to correct the balance of colors to make the lighting look more natural. You
adjust tint by locating a point that should be white, and then Digital Image Pro
balances all of the colors in the photo based on the white point you set.

If you have already used the levels auto fix tool, the tint problems in the photo
may already be corrected. Use the adjust tint tool to make additional adjust-
ments.

To adjust tint:

1 On the Touchup menu, click Adjust Tint.
The mouse pointer becomes an eyedropper.

2 With the eyedropper, click an area in the photo that should be white.
Picture It! automatically corrects the colors.

3 If you are not satisfied with the results, use the sliders for fine-tuning. Set
the Color slider to the color of the cast in the photo, and then use the
Amount slider to lower the amount of that color in the photo.

4 Click Done.

Fixing Red Eye
Using your flash indoors in low light situations can give your subjects red,
unnatural-looking eyes. The Fix Red Eye tool eliminates the redness.

Setting the white
balance on a
digital camera
Many digital cameras
allow you to set the
white balance for
specific types of light,
such as sunlight,
incandescent, and
flash. Using this
feature can help
reduce tint problems in
your photos.

Zooming in to
find white
If there are no
significant areas of
white in your photo,
use the zoom tool to
magnify the photo on
the screen. When you
zoom in, you may be
able to use a very
small area of white,
such as the white of a
person’s eyes.
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To fix red eye:

1 On the Touchup menu, click Fix Red Eye.
2 Use the pan and zoom controls to magnify your photo and focus on the

red eyes.
3 Click the red part of the eyes. You can click up to two eyes at once.
4 Click Red-eye auto fix.

The redness in the eyes disappears.
5 Repeat steps 3 and 4 as necessary.
6 Click Done.

Using the Airbrush
The airbrush tool can help to hide minor flaws such as facial blemishes or
stains. The airbrush tool works by sampling a color you select from the photo,
and then painting that color over the blemish or stain.

    

In the original photo on the left, the dog has a spot of ice cream on his nose. The airbrush tool
is ideal for covering up spots like this with a solid color.
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To use the airbrush tool:

1 On the Effects menu, point to Paint Brush, and then click Freehand.
2 Under Pick a paint tool, click the airbrush tool.
3 Click the color palette next to More color choices.

The pointer becomes an eyedropper.
4 With the eyedropper, click the color you want to paint with, and then

click Done.
5 Click a brush size.
6 Paint by dragging the brush on the photo.
7 If you are not satisfied with the airbrush color, click Reset, and then

repeat steps 2 through 5.
8 To make the airbrush effect more subtle, click Customize paint settings,

drag the transparency slider, and then click Done.
9 Click Done.

Cropping
Cropping is an easy way to improve the composition of a photograph. For
example, if your photo has distracting background elements, you can crop some
of them to focus attention on the subject. You can also remove unnecessary
regions from the top, bottom, or sides of the photo.

When you crop a photo, you are removing pixels, and therefore lowering the
resolution. If you crop a significant portion of your original, you’re limiting the
extent to which you will be able to enlarge the photo for printing. This is why
it’s better to compose the photo as best you can when you take it, rather than
relying on heavy cropping later.
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Cropping a photo allows you to eliminate distractions and improve the composition.

Cropping your photo to a specific proportion lets you control exactly where the
photo will be cut. Otherwise, if your photo is not the same proportion as the
print size, more of the photo will be automatically removed when you print it.

To crop a photo to a specific proportion:

1 On the Format menu, point to Crop, then click Canvas.
2 Under Select a proportion, click a print size.
3 Click a starting point on your photo, and then drag the outline to the

opposite corner of the area to be cropped.
The outline is proportional to the print size you selected.

4 Click Done.

Sharpening Your Photos
There are several times during the photography process that photos can become
blurred: while taking the picture, during printing, and during scanning. While
excessively blurry photos cannot be saved, the sharpen tool can improve the
focus of slightly blurry or moderately blurry photos. The sharpen tool increases
the contrast around the edges of objects in your photo.
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The sharpen tool can help blurry photos look more focused.

For the best results, sharpen the focus of your photo last, after you finish all
other enhancements.

To sharpen a photo:

1 On the Touchup menu, click Sharpen or Blur.
2 Drag the slider to the right until the photo is adequately sharpened.
3 Click Done.

For best results with the sharpening tool:

■ Be careful to use the sharpen tool in moderation. Especially when
printing, a photo that has been over-sharpened has an unnatural, wooden
look.

■ Don’t use the sharpen tool on a photo taken in low light that shows noise
(from a digital camera) or graininess (from a film camera). The sharpen
tool will accentuate the noise or grain in the photo.



Microsoft Picture It! Companion Guide

756 Using Special Effects

After you have touched up your photos, you can transform these images using
the many tools that Picture It! provides. Some special effects—such as the film
grain filter—mimic effects from traditional film photography. Other special
effects—like the chrome and glowing edges filters—give you access to the
creative possibilities unique to digital imaging.

Creating Cutouts
Compared to working with just one layer, creating cutouts gives you more
control and more options for editing images. You can use cutouts to edit with
more precision, fixing problems that only exist in part of the photo. Or, use
your imagination to make cutouts into funny or fantastic scenes.

You can create cutouts from any part of a larger picture, which enables you to:

■ Apply filters or other effects to a limited area of a photo.
■ Duplicate part of an image within a photo.
■ Combine parts from two or more photos.

From the original image (upper left), a cutout was made of the front most bottle. In the upper
right image, a filter was applied to the background. In the lower left photo, the bottle cutout
was copied to make more bottles. In the final photo, the background was replaced altogether,
putting the bottle in a totally new setting.

Cutting a hole
in a photo
You can use the trim
tool if you want to
remove just a part of a
photo—such as cutting
a hole. The trim tool is
located on the FormatFormatFormatFormatFormat
menu.
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You can create cutouts in four different ways. Select the method that best fits
your photo and your intended use for the cutout.

■ The Edge Finder works well if your photo has well defined edges along
where you want to cut.

■ Tracing on your own gives you the most precise control when cutting
irregular shapes.

■ Color Selection helps you cut away large areas of solid color.
■ Cutting with a cookie cutter shape cuts the photo into a shape such as a

circle, star, or heart.

To create a cutout:

1 On the Format menu, click Create a Cutout.
2 Click one of the following:

■ With the Edge Finder
■ By tracing an area on my own
■ By color selection
■ With a cookie cutter shape

3 Follow the instructions on the screen.

On the last screen of the cutout task, you will have the option to either:

■ Open the completed cutout In a separate project. Choose this option if
you plan to combine the cutout with other photos, or use the cutout in a
project such as a greeting card.

■ Leave it in the original project. Choose this option when you want the
cutout to remain in the original photo as a separate layer, so you can edit
it separately from the rest of the photo.

If you leave the cutout in the original project, you can select either the cutout or
the background in the Stack, and then edit the single layer.

Getting more Help
with cutouts
See the online Help
topic “Use cutouts” for
more detailed instruc-
tions on specific cutout
methods.
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Filters
The term filter originates from the colored glass covers placed over a camera
lens. The first filters in digital imaging sought to mimic the results of these
physical camera filters, providing a slight shift in color, or increasing the
intensity of colors. But the filters in Picture It! can create many other effects,
from sharpening an image to making the photo look like a painting or a mosaic.

Three different filters were used on the original photo (upper left): the colored pencil filter
(upper right), the emboss filter (lower left), and the stained glass filter (lower right).

To apply a filter:

■ On the Effects menu, point to Filters, and then click a filter.

Filters create a whole new look for your photos. Many filters make the image
look less like a photograph and more like a drawing, painting, mosaic, or other
hand-created artwork. Filter-enhanced photos can become an attractive focal
point of projects such as greeting cards and calendars.

Waiting for filters
to be applied
Some filters require
your computer to make
many calculations, so
on a slower computer
they may take a couple
of minutes to be
applied.
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Color Effects
You can give a color photo a new look by applying a color effect. Turn a
favorite color photo into an instant classic by changing it to black and white.
Or, apply the antique effect, which “ages” your photo by giving it a sepia tone.

To turn a color photo to black and white or antique:

■ On the Effects menu, click one of the following:
■ Antique
■ Black and white

Paint Effects
With the freehand paint brush, you can choose from several painting tools:

■ Paint brush
■ Airbrush
■ Pencil
■ Eraser
■ Highlighter
■ Chalk

Use these tools to add artistic effects to a photo.
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To use the freehand paint brush:

1 On the Effects menu, point to Paint Brush, and then click Freehand.
2 Click a painting tool, and then click a color.
3 Click a brush size, and then paint by dragging on the photo.
4 Click Done.

You can enliven your pictures with a rubber stamp effect. Choose from a
variety of stamp designs or make your own. Paint with a single stamp design,
or use multiple stamps on the same photo.

You can choose from a wide variety of stamps to customize any photo.

To paint with stamps:

1 On the Effects menu, point to Paint Brush, and then click Stamps.
2 Click a stamping style, and then click a stamp.
3 Click a stamp size, and then stamp by clicking on the photo.
4 Click Done.
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If you take photos regularly, it can be time consuming to edit all of your photos
as you download them from your camera. And once the photos are on your hard
disk, it can be a challenge to keep them all organized. Picture It! contains tools
that can help you save time with:

■ Routine editing on a batch of photos.
■ File management that helps you keep your photos organized.

Mini Lab allows you to batch-edit photos with tasks such as rotating, renaming,
and cropping. The file browser can help you manage your photos with tasks
like batch rename, batch move, and batch copy.

Batch Editing with Mini Lab
If you have a high-capacity storage medium in your camera, you may have
dozens or more photos to download at once to your hard disk. Some of these
photos may be excellent “keepers” that you will want to spend some time
editing carefully later on. But many of the photos only need a few quick edits:
changes like rotation and removal of red eye.

Opening each photo individually, performing basic edits, and then saving the
photos could take a lot of time. Instead, you can use Mini Lab to perform these
routine editing tasks on many photos at once. In Mini Lab you can select
multiple photos and perform the following tasks:

■ Levels auto fix
■ Rotate
■ Crop
■ Brightness and contrast
■ Fix red eye
■ Adjust tint
■ Save
■ Save as
■ Print

Mini Lab displays all of your open photos, and includes a list of editing options
that you can perform on multiple photos. This picture identifies the main
features of Mini Lab.
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1 2 3

5

4

6

1 Open more files opens the file browser to let you find more photos to
edit.

2 The editing options list shows all of the tasks available for batch editing.
3 File options let you save or print multiple photos.
4 The Workspace contains thumbnails of all of your opened photos.
5 Done closes Mini Lab, keeping the photos open and maintaining the

changes you have made. To save photos before leaving Mini Lab, select
the thumbnails and click Save before you click Done.

6 Cancel closes Mini Lab, undoing any unsaved changes.

To open Mini Lab:

■ On the Touchup menu, click Multi-photo edit in Mini Lab.

After you open Mini Lab, select the photos you want to edit, and then click one
or more editing tasks. Three of the batch editing tasks, levels auto fix, rotate
clockwise, and rotate counterclockwise, will be performed to all of the selected
photos at once. In other editing tasks, such as cropping, you can set your
preferences for each photo.
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Mini Lab does not automatically save your batch edits. To save your photos,
select photos and click Save. If you click Done to leave Mini Lab without
saving, the edits will remain in the photos for you to continue editing, but will
not be saved.

File Management with the File Browser
The file browser—the same window you use to open photos—can be used to
manage your photo files. The Tasks tab contains file-management tasks that
you can perform on multiple files. The file and folder tasks are:

■ Batch rename
■ Batch move
■ Batch copy
■ Duplicate

Batch rename
When you take photos with a digital camera, the camera usually names them
using numbers that are not helpful in identifying the photos. You can rename all
of these photos at once using a file name that makes sense to you.

When you rename the photos, you specify a base file name, and then Picture It!
adds a four-digit number to that base file name to ensure that each file name is
unique. For example, if you rename three JPEG files using “NewGuitar” as the
base file name, you will end up with three files: NewGuitar0001.jpg,
NewGuitar0002.jpg, and NewGuitar0003.jpg.

Batch move
If your digital camera is a USB Mass Storage Class device, you can use the
batch move feature to download the photos to your computer and erase them
from the camera at the same time.

Batch copy
When you copy your photos to a CD, you often need to copy many photos from
several locations to a single folder. The batch copy feature makes it easy to
move multiple photos to a folder which you can then copy to a CD.

Using the
file browser
For an explanation of
some of the other
features of the file
browser, see “Using
the File Browser” in
Chapter 3, “Opening
Photos in Picture It!”
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Duplicate
It’s never a good idea to edit your original photos, and the duplicate feature
makes it easy to ensure that you have copies. The duplicate feature copies each
selected photo and adds “Copy of” to the beginning of the copied photo’s file
name.

To manage files with the file browser:

1 On the Tools menu, click Manage Files in File Browser.
The Tasks tab is already selected.

2 If you want to manage files in a different folder, click the Folders tab,
click the folder you want, and then click the Tasks tab.

3 Press CTRL, and then select each photo you want in the right pane.
4 On the Tasks tab, click a file-management option.
5 Follow the instructions on the screen.
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When you’ve finished editing a photo, you can add polishing touches by
surrounding it with an edge, a border, a mat, or a frame.

Edge Effects
Edge effects alter the outside edge of a photo. For portrait photos, try the soft
edge effect. To draw attention to photos that you post on a Web site, try
applying one of the highlighted edges.

The photo on the left has highlighted edges applied, which works great for using photos on the
Web and in e-mail. The photo on the right has been enhanced with soft edges.

To add an edge effect:

1 In the Stack, click the layer to which you want to add the edge effect.
2 On the Effects menu, point to Edges, and then click an edge effect or

border.
3 Click a specific edge or border.
4 Follow the instructions on the screen to customize the size or color of the

edge or border.
5 Click Done.

Shrinking a photo
to show the edge
effect
Some edge effects
appear only behind
and outside the photo.
So if your photo
reaches the edge of
the canvas, you might
not be able to see the
edge effect when you
print it or save it to the
Web.

To make sure you can
see an edge you’ve
added, press CTRL
while you drag in one
of the photo’s corner
resize handles. This
will shrink the photo
proportionally on the
canvas, so that the
border lies within the
printable area.
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Mats and Frames
If you plan to put a photo in a traditional photo frame, you can add a Picture It!
mat to your photo before you print it. Mats create an elegant effect, and can
also help to fit an oddly-proportioned print to a standard size frame.

If you don’t plan to mount a photo in a traditional frame, but would like to print
and display it, use a Picture It! frame instead. You can choose from a variety of
frame themes to complement the subject of your photo. You can even add both
a mat and a frame to the same photo.

Picture It! has a wide variety of mats and frames to finish your favorite photos.

To add a mat or a frame:

1 Select the photo to which you want to add a mat or frame.
2 On the Effects menu, point to Edges, and then click Frames and Mats.
3 Click a theme, click a design, and then click Open.
4 Drag your photo from the Tray into the frame or mat, and then click

Next.
5 Move or resize the photo so that it fits within the frame, and then click

Next.
6 Click Done.

Choosing the right
mat
When choosing a mat,
consider the colors in
your photo and the
colors of your frame. A
mat should not
overpower the subject
of the photo. Try
selecting a soft-colored
mat that matches one
of the photo’s second-
ary colors.

Editing mats and
frames
Unlike edge effects,
mats and frames are
separate layers in your
photo project. So after
you’ve added a mat or
a frame to your photo,
you can edit the mat or
frame as a separate
layer.
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If you’re like most people, you can’t stand to throw photos away, even if
they’re imperfect. You probably have a large box or two filled with envelopes
of old negatives and photographic prints. Keeping track of all your old prints
and negatives can be a formidable task.

Fortunately, digital photography makes saving, storing, and organizing photos
much easier. However, there are some important things you should know about
saving your photos to make sure they’ll be in good condition whenever you
want to enjoy them.

Saving Multiple Versions
After you’ve downloaded a photo to your computer and erased it from your
camera, your computer’s hard disk contains the only copy of that photo. This
original version should be treated like a film negative: you don’t want to do
anything to it that will alter the original content. Besides rotating to correct
orientation and renaming the file, the original version should be left alone.

When you want to edit a photo or add it to a project, you should always make a
copy of the original and work with the copy. That way, if you make some
editing changes that you regret later, you can go back to the original, make a
new copy, and start over.

To make a copy of a photo:

1 Open the photo.
2 On the File menu, click Save As.

The file browser opens.
3 On the Folders tab, click the folder where you want to save the copy of

the original.
4 In the File name box, enter a name for the copy.
5 Click Save.

The file browser closes, with the new copy of the photo open in the
workspace.

Creating a folder
for edited photos
You may want to save
your edited photos in a
different folder from
your originals. To
create a new folder
from the file browser,
click the Create New
Folder button ,
and type a name for
the new folder. Then
double-click the folder
to open it to save your
photos inside.
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Choosing a File Format
Picture It! allows you to save photos in a number of image file formats. You
can determine the best format for saving your photos based on what you will
use the photo for, compatibility with other computers, and file size. To help you
understand the difference between file formats, here are some important
characteristics of three common image formats:

■ Picture It! PNG Plus (.png+) saves the layers in your photo projects so
you can edit them later. PNG plus offers lossless compression, but not all
computers have the software to open PNG plus files.

■ TIFF (.tif) is a common format for cameras that produce lossless images.
TIFF does not support layers, but is a good format for saving important
photos, although the files are relatively large.

■ JPEG (.jpg) is the most common format for images since the files can be
opened on practically any computer. JPEG does not support layers. JPEG
compression reduces image quality slightly, but makes small files that
work well most purposes, especially for e-mail and the Web.

To save a photo in a specific file format:

1 On the File menu, click Save As.
The file browser opens.

2 In the Save as type box, click a file type.
3 Click Save.

Saving for E-mail and the Web
Unlike photos for printing, photos for e-mail and the Web work best if they are
relatively low resolution. Low-resolution files, such as one that is 440 x 330
pixels, move faster through dial-up modems, and they are the right dimensions
for viewing on most computer monitors.
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To save a photo for e-mail or the Web:

1 On the File menu, point to Save Special, and then point to Save as Web-
ready Picture.

2 Click a picture size, and then click Next.
The file browser opens.

3 On the Folders tab, click the folder to which you want to save the photo.
4 In the File name box, enter a file name, and then click Save.

Long-term Storage on CD, Zip Disk, or DVD
Whether you take photos for personal or professional use, it would be tragic to
lose your photos due to a fire, flood, or problem with your computer hard drive.
You should back up your photos periodically to avoid loss, just as you would
with other important files on your computer. Fortunately, backing up your digital
photos is much more convenient and inexpensive than backing up film negatives.

To back up your photos, you have a variety of storage options. A few of the
most popular and practical options are outlined here:

■ Zip drive An internal or external Zip drive is probably the least expen-
sive drive you can add to your computer for high-capacity storage. Zip
disks are available in 100-MB and 250-MB capacities, and the disks offer
a rewritable format that works essentially like a floppy disk. If you get an
external Zip drive, look for a USB or FireWire® connection for fast data
transfer.

■ CD burner Many new computers come with a CD burner, which can
copy photos to a CD-R or CD-RW disc. CD-R discs can only be copied to
once, while CD-RW discs can be copied to multiple times. Either way,
the blank discs are inexpensive. And at up to 700 MB per disc, you can
store a lot of photos at a very low cost.

■ DVD burner DVD burners are relatively new to the photo storage scene,
but they show a lot of promise. There are a number of slightly different
formats to choose from, including DVD-RAM, DVD-R, DVD-RW, and
DVD+RW. While there are still some compatibility issues to be worked out
for DVD burners, the enormous capacities of DVD discs—up to 4.7 GB
can be saved on a single DVD disc—is very attractive for storing photos.

Copying Photos to a Zip Disk
You can use the file browser to copy a whole batch of photos at once.

Avoid sending
large photos
in e-mail
Sending high-resolu-
tion photos in e-mail
may cause problems
for your recipients. For
example, a single 5-
MB, high-resolution
image will take over 20
minutes to download
on a 28.8 Kbps
modem. Also, some e-
mail programs limit the
size of attachments,
and may, for example,
block e-mail with
attachments larger
than 1 MB.
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To copy photos to a Zip disk:

1 Insert a blank Zip disk into your Zip drive.
2 On the File menu, click Open.

The file browser opens.
3 On the Folders tab, click the drive or folder containing the photos or

folders you want to copy.
4 In the right pane, select the photos or folders you want to copy.

To select multiple photos, press CTRL while you click the photos.
5 Click the Tasks tab, and then click Batch copy.

The Batch copy dialog box opens.
6 Click Browse.

The Browse for folder dialog box opens.
7 Click My Computer, click the Zip drive, and then click OK.
8 In the Batch copy dialog box, click OK.

The photos are copied to the Zip disk.
9 In the file browser, click Cancel.

Copying Photos to a CD
For copying photos to a CD, the procedure varies depending on your operating
system and your particular model of CD burner.

Copying photos to a CD in Windows XP

If your computer is running Windows XP, you can use the CD Writing Wizard
to copy photos to a CD.
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To copy photos to a CD in Windows XP:

1 Insert a blank, writable CD into the CD recorder.
2 Click Start, and then click My Computer.
3 Click the Folders button, and then in the left pane, browse to the folder

containing the pictures you want to copy.
4 Click the photos or folders you want to copy to the CD. To select more

than one photo, hold down the CTRL key while you click the photos you
want.

5 Click the Folders button again.
6 Under File and Folder Tasks, click Copy this file, Copy this folder, or

Copy the selected items.
7 In the Copy Items dialog box, click the CD recording drive, and then

click Copy.
8 In My Computer, double-click the CD recording drive. Windows

displays a temporary area where the photos are held before they are
copied to the CD. Verify that the photos and folders that you intend to
copy to the CD appear under Files Ready to be Written to the CD.

9 Under CD Writing Tasks, click Write these files to CD. Windows
displays the CD Writing Wizard. Follow the instructions in the wizard.

Copying photos to a CD in Windows 98, Windows 2000, or Windows Me

If your computer is running Windows 98, Windows 2000, or Windows Me, you
should follow the instructions for your CD burning software to copy photos to a
CD. With some CD burners, you have to first copy photos stored in multiple
locations to a single folder before you copy the photos to a CD.

To copy photos from multiple locations to a folder before copying
them to a CD:

1 On the Picture It! File menu, click Open.
The file browser opens.

2 On the Folders tab, click the disk or folder containing the photos or
folders you want to copy.

3 In the right pane, select the photos or folders you want to copy.
To select multiple photos, press CTRL while you click the photos.

Copying to a
DVD burner
You can use the file
browser to copy image
files to a folder to be
copied to a DVD
burner. Then follow the
instructions provided
with your DVD burner
to copy the files to the
disc.
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4 Click the Tasks tab, and then click Batch copy.
The Batch copy dialog box opens.

5 Click Browse.
The Browse for folder dialog box opens.

6 Click a location where you want to create the backup folder.
7 Click Make New Folder.

A new folder named New Folder is created.
8 Click OK.
9 In the Batch copy dialog box, click OK.

The photos are copied to the new folder.
10 In the file browser, click Cancel.
11 Follow the instructions for your CD burner to copy photos from the New

Folder to the CD.

Saving To MSN Photos
MSN Photos is an online Web photo service that compliments Picture It!
features. After you save photos on MSN Photos, you can:

■ View photos online from home, work, or anywhere.
■ Share photos with family and friends.
■ Order prints and create photo gifts.

When your computer is connected to the Internet, you can save photos directly
from Picture It! to MSN Photos.

To save a photo to MSN Photos

1 Make sure your computer is connected to the Internet.
2 Open all of the photos that you want to save so that they appear in the

Tray.
3 On the File menu, point to Save to the Web, and then click Save to MSN

Photos.
4 Click The current picture or All open pictures in the Tray.
5 Click Next.

The MSN Photos Web site appears in the workspace.
6 Follow the instructions on the MSN Photos Web site.

Signing up with
Microsoft .NET
Passport
To use MSN Photos,
you must have a
Microsoft .NET
Passport. All
hotmail.com and
msn.com e-mail
addresses are .NET
Passports. If you don’t
yet have a .NET
Passport, it’s free to
sign up, and you can
get to the sign-up page
by following the
instructions for saving
to MSN Photos.

Using MSN Photos
For more information
on MSN Photos, see
the sections on MSN
Photos in the following
chapters:

■ Opening Photos in
Picture It!

■ Printing Photos

■ Sharing Photos
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Archiving Photos in the Gallery
Picture It! enables you to archive your pictures in the Gallery using custom
categories, which you can name and organize in whatever way makes sense to
you.

The Gallery is not a storage location for your pictures. It simply stores informa-
tion about your pictures, including the file name, storage location, categoriza-
tion, keywords, and a date. Later, when you want to find a picture in the
Gallery, you can search for it using any or all of these variables.

To add photos to the Gallery:

1 On the Tools menu, click Edit Items in the Gallery.
2 Click Add Items to the Gallery.

The file browser opens.
3 On the Folders tab, click the folder containing the photos you want to

add to the Gallery.
4 Press CTRL, and then select the thumbnails.
5 Click Open.
6 In the Categories list, check the box for each category you want.
7 To create a new category, click Add/Rename/Delete category.
8 In the Keyword box, type the keyword, and then click Add.
9 In the Date box, enter a date.

10 Click Apply.
11 Click Done.

After you have added a photo to the Gallery, you can locate it later by searching
by category, keyword, or date.
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To find and open a photo from the Gallery:

1 On the File menu, point to Get picture from, and then click Gallery.
The Gallery opens.

2 Click the Find tab.
3 Do one or more of the following:

■ Type one or more words describing the item(s) you want to find.
■ Check the Advanced find box, and then enter a date range.
■ Check the Advanced find box, and then select the type of item you

want to find.
4 Click Find.
5 Click the thumbnail you want, and then click Open.



Microsoft Picture It! Companion Guide

9510 Creating Projects

A great way to present your photos and share them with friends and family is to
create photo projects. Picture It! offers a range of designs that you can use to
showcase your photos. Choose from greeting cards, calendars, business cards,
and more.

Creating Photo Cards
Use your own photo to personalize a greeting card for a holiday, a party
invitation, or any other occasion.

To open a photo card design:

1 Open a photo so that it is in the Tray.
2 On the File menu, click Create a Project.
3 On the Pick a Design page, click Cards.
4 Click Photo Cards.
5 Click a theme, click a design, and then click Open.
6 Drag your photo from the Tray to the card, and then click Next.
7 If you want, move, resize, or flip the photo.
8 Click Done.
9 To edit the inside pages, make sure the Common Tasks list is expanded,

and then click the page icons at the bottom of the Common Tasks list.

After your card project is open, you can add your own text, photos, and clip art.
Because most printers cannot print to the edge of the page, the purple margins
on the edges of a card project represent the unprintable areas of the card.

Photo cards are either half-fold cards, which are larger cards printed on both
sides of the paper, or quarter-fold cards, which are smaller cards printed on
only one side of the paper.

A favorite golfing photo was used to create this half-fold card.
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To change the fold style of a card:

■ On the Format menu, click Change Card Fold.

Creating Calendars
Calendars are a great way to showcase your favorite photos. Calendar projects
are available in one-week, one-month, 12-month, and one-year formats.

A one-week calendar. A one-year calendar.

A one-month calendar.
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These are the first three pages of a 12-month calendar.

To create a calendar project:

1 On the File menu, click Create a Project.
2 Click Calendars.
3 Click a calendar type.
4 Click a theme, click a design, and then click Open.
5 Set the start date for the calendar, and then click Next.
6 Follow the instructions on the screen to add a photo to your calendar, and

then click Next.
7 Move or resize your photo on the calendar. Use the corner resize handles

to resize the photo proportionally.
8 Click Done.

When you create a 12-month calendar, you can add different photos to each page.

To add photos to a 12-month calendar:

1 Complete the instructions above to create a 12-month calendar.
2 Open the photos you want so that they are in the Tray.
3 Make sure the Common Tasks list is expanded.
4 Click the page icons at the bottom of the Common Tasks list to switch

between pages.
5 Drag photos from the Tray into each page.
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One of the biggest advantages of digital photography over traditional film
photography is the ease with which you can share your photos. Rather than
creating paper prints for everyone who wants to see your photos, you can share
a digital copy of a photo with an unlimited number of people. When you post
photos on MSN Photos, send photos through e-mail, or post photos on a Web
site, friends and family around the world can see your photos just minutes after
you take them.

If you have photos, share them!

Sending by E-mail
If you have a single photo to share, you can use Picture It! to send it to your
friends and family. If you want to send a high-resolution photo, Picture It! can
help you easily optimize the photo to be sent through e-mail, which:

■ Reduces the file size so that the photo moves faster through Internet
connections.

■ Reduces resolution so that the photo is sized properly to be viewed in
most Web browsers.

■ Converts the photo to the JPEG format, which can be opened on most
computers.

Picture It! uses the default e-mail program on your computer to create an e-mail
message with your photo as an attachment.

To send a photo by e-mail:

1 Open the photo so that it is in the workspace.
2 On the File menu, point to Send As, and then click Picture Attachment.
3 Click a picture size.

The file size of the resized photo is displayed, along with download times
for different types of Internet connections.

4 Click Next, and then click Put the project in an e-mail message.
A new e-mail message opens with your photo already attached.

5 Type your recipient’s e-mail address in the To line of the message.
6 The e-mail message will already have a subject and instructions on how

to open the photo. If you want, enter a new subject and additional text to
the message.

7 Click Send.

Sending multiple
copies
You can send your
photo by e-mail to
multiple people at the
same time. Just
include all of your
recipients’ addresses
on the ToToToToTo line of the e-
mail message.
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Sharing on MSN Photos
MSN Photos is a convenient and fast way to share a group of photos or share
photos with a whole group of people. Whether you want to share with just a
few friends and family, or many people around the world, MSN Photos makes
it easy. In addition to showing your photos to your recipients, you can also let
them order prints or gifts with the photos.

When you share photos on MSN Photos, you have the option of allowing your
recipients to:

■ Download high-resolution photos to their computer.
■ Order prints and gifts of your photos.

With a connection to the Internet, you can upload photos directly from Picture
It! to MSN Photos.

To share photos to MSN Photos:

1 Make sure your computer is connected to the Internet.
2 Open all of the photos that you want to save so that they appear in the

Tray.
3 On the File menu, point to Save to the Web, and then click Save to MSN

Photos.
4 Click The current picture or All open pictures in the Tray.
5 Click Next.

The MSN Photos Web site appears in the workspace.
6 Follow the instructions on the MSN Photos Web site.

Signing up with
Microsoft .NET
Passport
To use MSN Photos,
you must have a
Microsoft .NET
Passport. All
hotmail.com and
msn.com e-mail
addresses are .NET
Passports. If you don’t
yet have a .NET
Passport, it’s free to
sign up, and you can
get to the sign-up page
by following the
instructions for saving
to MSN Photos.

Using MSN Photos
For more information
on MSN Photos, see
the sections on MSN
Photos in the following
chapters:

■ Opening Photos in
Picture It!

■ Saving Photos

■ Printing Photos
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Picture It! offers several options for printing photos on your desktop printer.
You can optimize settings for the print size, print quality, orientation, and
photos per page. This chapter describes the procedures for printing a single
print or multiple prints. You’ll also learn how to get great prints by selecting the
right print size, settings, ink, and paper.

Printing a Photo

To print a single photo:

1 Make sure your printer is turned on and connected to your computer.
2 On the File menu, click Print.
3 Under Select a printer, click a printer.
4 To specify printer settings, click Change printer settings.
5 Select the number of copies, and then select a print size.
6 Click Print.

Printing multiple photos
When you have finished editing a series of photos, you can print two, four, or
more photos on a single page.

Printing on a multi-photo sheet saves paper and is a convenient way to create prints to give to
family and friends.

Installing printer
drivers
When adding a new
printer, make sure that
you install all the
printer software and
drivers. If you’re
installing an older
printer, you may be
able to find updated
printer drivers on
the manufacturer’s
Web site.
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To print multiple photos on the same page:

1 Open the photos you want to print, and make sure that they all have the
same orientation.

2 On the File menu, point to Print Special, and then click Multi-photo
Sheet.

3 Under Click a printer, click a printer, and then click Next.
4 Under Click a category, click your brand or type of photo paper.
5 Click an orientation, click a template, and then click Next.
6 Click Several projects, and then click Next.
7 Do one of the following:

■ To fit each picture within the print area without cropping, click Fit
within area.

■ To make your pictures fill the whole print area, click Overlay and
crop.

8 From the Tray, drag your pictures onto the shaded areas of the template,
and then click Next.

9 Select the number of copies you want to print, and then click Print.

Printing Labels or on Special Paper
You can print different kinds of labels, including address labels, shipping
labels, and full-sheet labels. In addition, you can print your photo on various
kinds of paper, including photo paper, T-shirt transfer sheets, and magnet
sheets. Refer to your printer’s manual to determine the types of paper on which
it can print.

To print labels or on special paper:

1 On the File menu, point to Print Special, and then click Labels or
Special Paper.

2 Select a printer and printer settings, and then click Next.
3 Under Click a category, click a category of layouts.
4 Click either Portrait or Landscape orientation.
5 Click a template, and then click Next.
6 Click One project or Several projects, and then click Next.

Rotating photos
for printing
When printing multiple
photos, they will all
come out the same
size if they are rotated
to the same orienta-
tion. When a photo is
in the workspace, you
can rotate it by clicking
one of the rotate
buttons on the
toolbar.
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7 To fit your entire photo into the print area, click Fit within area.
- or -
To fill the print area with your photo, click Overlay and crop.

8 Drag your photo or photos from the Tray into the template, and then click
Next.

9 Select the number of copies you want to print, and then click Print.

Printing Cards
Greeting cards often require printing on both sides of the paper, so they often
require a few extra steps in the printing process. Quarter-fold cards print on a
single side of the paper and do not require special procedures. Printing a half-
fold card, by comparison, requires that you print on both sides of the paper.
This printing must be done properly so that the text on the inside of the card is
positioned on the correct side and at the correct orientation.

To print a half-fold card:

1 On the File menu, click Print.
2 Select a printer, printer settings, and the number of copies you want to

print, and then click Next.
3 Select the pages to print.
4 Select whether you want to print on one side of the paper or both sides.
5 If appropriate, select the This printer can automatically print on both

sides of the paper check box.
6 Click Print.

Before the card is actually printed, Picture It! may conduct a short print test.
This test will occur the first time you select the option to print on both sides of
the paper if you’re using a printer that cannot do it automatically. After the test
is completed, Picture It! will help you correctly insert the card into the printer
for printing on both sides.
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Selecting Print Quality
Most desktop printers are capable of printing in a range of qualities, from a
low-quality draft mode to a high-quality setting that requires more time and
uses more ink. Printer settings for quality and color vary, but you may be able
to specify your paper type, ink type, dots per inch required, and color manage-
ment preferences. Some printers have simplified printing options such as
“Good,” “Better,” and “Best.” Make sure to read your printer’s manual to find
out how to take advantage of these different settings.

To select print quality for your printer:

1 On the File menu, click Print.
2 Click Change printer settings.

Your printer’s dialog box opens.
3 Adjust your printer’s quality settings, and then click OK.

Selecting a Print Size
The quality of photo prints is directly related to the number of pixels in the
photo. A high-resolution photo contains a lot of detailed visual information, and
can be printed at larger sizes. For example, a photo whose dimensions are 2048
x 1536 pixels (3.1-megapixel) would look good even when printed as large as
8” x 10” on most printers.

A low-resolution photo has less detailed visual information, and therefore
cannot be printed in larger sizes. A photo with pixel dimensions of 1280 x 960,
for example, lacks the detail needed to fill an 8” x 10” print. The result would
be a grainy, pixilated image. But printing this photo at a smaller size, such as 4”
x 6”, would give you a sharp, detailed print.

Determining a photo’s pixel dimensions
How do you determine the number pixels in a photo? If you haven’t cropped
the photo since you’ve taken it, you may know the pixel dimensions that you
had set on your camera for that photo. But if you don’t remember how you set
the camera or if you have cropped the image, you can check to see a photo’s
pixel dimensions before you print it.

Turning on color
management
Check your printer’s
manual to see if it
offers color manage-
ment. Color manage-
ment can help your
printer to produce
colors that match the
ones on your monitor.
If your printer offers
color management,
click Change pictureChange pictureChange pictureChange pictureChange picture
settingssettingssettingssettingssettings while perform-
ing the Print task. Your
printer’s dialog box will
open, and you can
adjust the settings for
color management.
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To check a photo’s pixel dimensions:

1 On the Format menu, click Resize Image.
2 Under Select a page size, set the Units box to pxl.

The Height and Width boxes fill with the pixel dimensions.
3 Click Cancel.

How large a print can you get?
When you print a photo, you can set the printer to print at a variety of sizes,
which is expressed as dots per inch (dpi), or sometimes called pixels per inch
(ppi). Different desktop printers vary as to how much resolution they require
for the same print sizes. Some printers can produce crisp sharp prints at only
about 150 dpi, other printers require 300 dpi to produce quality prints. Experi-
ment with your printer to see what kind of prints it can produce.

Use this table as a guide to see how large a print you can make from your photo:

Print size Pixels required Pixels required Pixels required
for 150 dpi for 200 dpi for 300 dpi

3.5” x 5” 525 x 750 700 x 1000 1050 x 1500

4” x 6” 600 x 900 800 x 1200 1200 x 1800

5” x 7” 750 x 1050 1000 x 1400 1500 x 2100

8” x 10” 1200 x 1500 1600 x 2000 2400 x 3000

After you’ve determined how large you want the print to be, you can select a
print size during the print task.

To select a print size and print:

1 On the File menu, click Print.
2 Under Select a print size, click a print size.

- or -
Under Select a print size, click Custom, and then enter specific dimen-
sions in the height and width boxes.

3 Click Print.
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Choosing Photo Paper
If you want your images to look like traditional photographs, choose paper that
is clearly labeled as photo paper. Photo paper comes in a range of thickness and
texture. Paper weight ranges from ordinary office-document weight to a fairly
heavy watercolor paper. If you choose a heavyweight paper, check your
printer’s manual to make sure that your printer can handle it.

The quality of the image will be affected by the kind of paper stock you choose.
As a rule, you’ll see the widest range of colors and get the deepest blacks from
paper that has been specially coated to accept inkjet inks. The range of colors
appears to be widest on the whitest papers. Glossy surfaces also create the
illusion of deeper blacks. However, if you’re going to display your prints,
glossy surfaces can cheapen the look of the work, and surface glare can make
the images more difficult to view.

Paper formulations also contribute greatly to resisting fading and color shifting.
If you’re using “fade-resistant” or “archival” inks, look for coated, acid-free
papers that are also advertised as fade-resistant or archival.

Creating Long-lasting Prints
How long can you expect a print to last? With some inkjet prints, you can only
expect a fade-free lifespan of two months to two years. All of the major printer
manufacturers are beginning to advertise greater image stability for the output
of certain printer/ink combinations, but few of these manufacturers claim that
prints will last more than about four years.

When buying supplies for your printer, check which types of ink and paper are
recommended by the manufacturer of your printer, and find out about the ink’s
lifespan rating. Some six-color printers use inks specially formulated for long
life. When printed on high-quality heavyweight matte paper, photos from these
printers can last approximately 40 years before perceptible fading occurs.

Fade ratings are given as the amount of time before any color shift in the print
can be seen by the naked eye. The actual time it would take for the print to
become unacceptably discolored would be several times that. These ratings are
based on indoor exhibition under glass in an atmosphere that is not chemically
polluted. Ozone is especially harmful to dye-based printing inks. Do not
display these prints in rooms where oxygen tanks or electric air fresheners are
used—both produce high amounts of ozone.
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Printing from MSN Photos
Order prints of your photos online at MSN Photos and have the prints sent to
you or your family and friends. On MSN Photos, you can also use your photos
to create a variety of photo gifts.

To order prints and enlargements:

1 On the File menu in Picture It!, point to Print Professionally Online,
and then click Prints and Enlargements.

2 To open additional photos that you want to use for ordering prints and
enlargements, click Add or remove pictures, and then follow the
instructions on the screen.

3 Click The current picture or All open pictures in the Tray.
4 Click Next.
5 Order the prints and enlargements you want.
6 Click Done.

To order photo gifts:

1 On the File menu in Picture It!, point to Print Professionally Online,
and then click Photo Gifts.

2 To open additional photos to use for ordering photo gifts, click Add or
remove pictures, and then follow the instructions on the screen.

3 Click Next.
4 Order the photo gifts you want.
5 Click Done.

Signing up with
Microsoft .NET
Passport
To use MSN Photos,
you must have a
Microsoft .NET
Passport. All
hotmail.com and
msn.com e-mail
addresses are .NET
Passports. If you don’t
yet have a .NET
Passport, it’s free to
sign up, and you can
get to the sign-up page
by following the
instructions for saving
to MSN Photos.

Using MSN Photos
For more information
on MSN Photos, see
the sections on MSN
Photos in the following
chapters:

■ Opening Photos in
Picture It!

■ Saving Photos

■ Sharing Photos
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AAAAA
AC power adapter  14
action mode  27, 28
action photography

burst mode feature  29
children  27, 29
compensating for shutter lag  28
digital cameras  27
freezing action  22, 27, 28
higher speed film  24
moving subjects  27, 28
shutter speeds  22, 23

adjusting
aperture  21
depth of field  21
exposure settings  19
lens focal length  13

Advanced Photo System (APS) cameras
31

airbrush tool  71
ambient light  16
aperture

action mode  27
adjusting  21
affecting depth of field  21
affecting focus  21
automatic mode  18
controlling exposure  18, 22
definition  20
determining correct setting  22
fixed  21
focus  17, 21
portrait mode  30
priority mode  22
program modes  21
reducing  26
shutter priority mode  23
size  20, 21

archiving photos  93
artifacts  11
aspect ratio  31
attaching photos  99
autofocusing  32
automatic

cameras  17, 18, 25, 39
exposure  19
flash  17
modes  26

BBBBB
background

analyzing  35
balancing  37
blurriness  21, 28
details  35, 38, 72
light  34
simplifying  30

backing up images  83
balance settings  25
base file names  83
batch editing  81
batteries  14
blurriness

increasing  21, 28
reducing  22, 23, 73

borders, adding  85
bracketing

automatic cameras  39
definition  39
still objects  39

brightness,
adjusting images  69

buffers  29
built-in

flashes  15
light meters  34
zoom lens  13

burning CDs  83, 89
burst mode  29

CCCCC
calendars  96
camera, opening photos from  46
candid shots  13. See also zoom lens
canvas  56
card reader  45
CCD  10
CD  13, 43, 83, 89
centering objects  59
charge-coupled device  10
children, photographing  27, 29
chips

CCD  10
CMOS  10

clip art  95
close-up photography  26, 27. See also

zoom lens
cloudy days. See also overcast

conditions
adjusting exposure settings  19
balance settings  25
correcting light levels  20

CMOS  10
color

affected by exposure  18
applying color effects  78
balance settings  25
correcting tint  70
grouping pixels  11
incandescent lights  25
lighting effects  36
white balance  24

Common Tasks list  55
compact cameras  18
CompactFlash  13
compensation, exposure  34, 39
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composing photos  37
composition

assessing  40
improving  72
techniques  33
transforming  38, 72

compression
artifacts  11
definition  11
experimenting with settings  12
JPEGs  11, 88
lossless  12, 88
reducing file size  11, 87
TIFFs  12, 88

computers
memory requirements  12
storage options  89

contrast, adjusting  69
copying images  49, 83, 84, 87
copyrights  49
correcting light levels  20, 69
creating

calendars  96
photo cards  95
projects  95

cropping images  72
cutouts  75

DDDDD
daylight. See sunlight
depth of field

affecting with aperture  21
definition  21
shallow  21, 30
widening  26

digital cameras
action photography  27
battery usage  14
exposure compensation feature  39

megapixel rating  10
opening photos  43, 46
time lag  27

digital imaging filters  77
digital zoom  8, 13. See also zoom lens
dimensions, pixels  9, 105
disposable alkaline batteries  15
downloading pictures  50, 83
dpi (dots per inch)  105
duplicate feature  84
DVD  43
DVD burners  89

EEEEE
e-mail

opening photos  49
receiving photos  49
sending photos 9, 88, 99

edge effects  85
editing images  69, 75, 81
enhanced resolution  10
enlarging

photos  9
estimating file sizes  9
EV setting  39
exposure

assessing  40
bracketing  39
compensation  34, 39
correcting light levels  20, 69
definition  18
determining correct setting  22
helpful tips  34, 39
ISO rating  18
long  32
overexposure  18, 34, 69
underexposure  18, 34, 69

FFFFF
f-stop  20
file browser  43, 84
file formats  12, 48, 88
file size

estimating  9
higher resolution  9
JPEGs  12, 88
limiting  9, 88
lossless compression  12, 88
lower resolution  10
photo quality  10
reducing  11, 88, 99
TIFFs  12, 88

fill flash  17. See also flash
film grain filter  75
films

daylight  24
speed  17, 18, 23, 24

filters, digital imaging  77
flash

automatic setting  17
battery usage  14
causing red-eye  16, 70
filling in shadows  17
learning to use  15
night photography  16, 23
settings  15, 16
turning off  15, 27

floppy disks  13, 14
focal length

adjusting  13
macro mode  26

focus  21
framing images  85
freezing action  22, 27, 28
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GGGGG
Gallery  93
gifts  107
graininess  24, 74
greeting cards  95, 103
grouping objects  63

HHHHH
Help resources  65
high-capacity storage  89

IIIII
image sensors

buffering  29
capturing photos  13
controlling exposure time  21
definition  10
digital cameras  10, 24
increasing sensitivity  16
megapixel rating  10
overexposure  18
setting resolution  10

images
adjusting brightness and contrast  69
applying color effects  78
archiving  93
backing up  83
copying  49, 83, 84, 87
correcting tint  70
cropping  72
opening  43, 49
paint effects  78
printing  101, 103
rotating  44, 62
saving  49, 50, 88, 92
scanning  47
sending through e-mail  9, 49, 99
sharpening  73

incandescent lights  25, 40, 70
installing

Picture It!  3
printer drivers  101

interpolation  10, 13
ISO rating  18, 19

JJJJJ
JPEGs

compressing  11, 88
file sizes  9, 88
overview  12, 88

LLLLL
labels, printing  102
LCD preview screen  14, 15, 28, 39
light

adjusting exposure settings  19
assessing  40
correct exposure  18, 69
correcting levels  20, 69
incandescent  25, 70
lighting tips  35
overexposure  18, 34, 69
shooting in low light  16
underexposure  18, 34, 69

light meter  34, 39
lossless

compression  12, 88
low-resolution  9, 10, 49, 72

MMMMM
macro mode  26, 27
manual cameras  17, 18
maximum print size  9, 105
megapixels  9, 10, 89, 105
memory  12
memory cards and sticks  13, 14, 43

microdrives  13
middle gray  19
midtones  19, 20
Mini Lab  81
modes, camera  18, 25
motion photography. See action

photography
MSN Photos  42

opening photos from  50
ordering prints and gifts  107
saving photos  92
sharing photos  100

multipattern light metering  27
multiple photos, editing  81
multiple selection  62

NNNNN
naming files  83
narrow aperture  21
nickel metal hydride  14
noise  24, 74

OOOOO
object handles  59
online Help  65
opening

Mini Lab  82
photo card designs  95
photos  43, 49

optical zoom  13
ordering enlargements  107
ordering prints and gifts 107
organizing photos  81
overcast conditions. See also cloudy

days
overexposure

definition  18, 34, 69
oversized prints  105
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PPPPP
paint effects  78
pan control  57
panning  28
panoramic

cameras  31
mode  25, 31

perspectives  38
photo cards  95
Photo CD  48
photo gifts  107
photo paper  102, 106
photo quality

affected by camera quality  10
automatic cameras  18
correcting problems  69
deciding file formats  12, 88
interpolation  13
JPEGs  88
manual cameras  18
pixel visibility  8
printing considerations  105
red eye  16, 70
reduced by compressing  11, 88
resolution  9
setting correct exposure  18
settings  10
shutter speed  18
TIFFs  12, 88
underexposure  69

photo series  29
photos. See images
Picture It!

editing images  69
exploring work area  54
installing  3
instructional videos  68

opening images  43
printing images  101
reinstalling  5
removing  5
saving images  87
scanning images  47
technical support  68
tour  68
upgrading  5

picture series  25
pixels

definition  8
determining number  104
interpolation  13
noise  24, 74
panoramic mode  31
removing  72, 99
using digital zoom  13

portrait mode  30
portraits  17, 21, 30
power adapter  14
power, conserving  15
presenting photos  86, 95
previewing photos  14, 15, 39
print size  10, 105
printer

drivers  101
inks  106
settings  104

printing
from MSN Photos  107
labels  102
photo cards  95
photos  9, 101, 103
resolution  104
small print sizes  10

program modes  21, 25

projects
calendars  96
creating  95
photo cards  95

RRRRR
rechargeable batteries  15
red eye  16, 70, 81
reinstalling Picture It!  5
removable storage media  13, 14, 44, 45
removing red eye  81
removing Picture It!  5
renaming images  44, 83
resize handles  59
resizing images  58, 60, 104
resolution  72, 88, 104
rotating images  44, 62
rotate handle  59
rule of thirds  37, 38

SSSSS
saving images  49, 87, 92
saving images from Web pages  50
saving photos in different formats  12,

88
scanners  47
self-timer feature  32, 39
sending images through e-mail

9, 88, 99
sensitivity setting  24
setting

correct exposure  18
resolution  10

setup. See installing
shadows  15, 17
sharing photos  99
sharpen tool  73
sharpening images  73
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showing photos  42
shutter. See also shutter speeds

activating with self-timer  27
autofocusing  32
definition  22
lag  28, 29
priority mode  23

shutter speed
action mode  27
definition  18
determining correct setting  22
measurements  22
night photography  23
reducing blurriness  23
stopping action  22

SmartMedia  13
snow  20
special effects  75
special paper  102
splotchy color  11
Startup Window  53
stopping action  22, 28. See freezing

action
storage

disk  12, 89
file size limitations  9
media  14, 29, 31
technology  14, 89

storing photos  10, 14, 87, 89, 92
stretching objects  61
sunlight  17, 24
support, technical  68

TTTTT
technical support  68
telephoto lens  30
text, adding 64

TIFFs
compression  12, 88
file size  12, 88
lossless compression  12, 88
overview  12, 88
photo quality  12

time lag  27
tint, correcting  70
tips

assessing composition  40
composing photos  37
equipment  33
exposure  34, 39
gaining experience  41
lighting  35

toolbar  56
tour Picture It!  68
Tray  56
tripods

close-up shots  27
makeshift  32
mounting cameras  23, 32
reducing blurriness  23

TWAIN support  46
twilight  36

UUUUU
underexposure

causes  34
definition  18
fixing 69

upgrading
Picture It!  5

uploading to the Web  100
USB Mass Storage Class devices  45

VVVVV
videos, instructional  68
viewfinder  15, 28

WWWWW
Web browser  12
Web images, editing  50
Web sites

editing Web images  50
uploading photos  88

white balance  24, 25, 40, 70
WIA support  46
wide-angle lens  31
widening depth of field  26
workspace  56

ZZZZZ
zoom lens  13, 30



Microsoft Picture It! Companion Guide

Index114



Microsoft Picture It! Companion Guide

115Index



Microsoft Picture It! Companion Guide

Index116



Microsoft Picture It! Companion Guide

117Index



Microsoft Picture It! Companion Guide

Index118



Microsoft Picture It! Companion Guide

119Index



Microsoft Picture It! Companion Guide

Index120



Microsoft Picture It! Companion Guide

121Index



Microsoft Picture It! Companion Guide

Index122


